# TABLE OF CONTENTS

## GETTING STARTED

- Dashboard ......................................................... 6
- Toolbar ......................................................... 6
- Preferences ...................................................... 6
- OnePass Settings window ................................. 6
- Recent window ............................................... 6
- Today's Time window ......................................... 6
- Search View .................................................... 6
- Record View .................................................... 7
- Status and Progress Bars .................................. 7
- Toolbars ......................................................... 7
- Menus ............................................................ 7
- Keyboard Shortcuts .......................................... 7
- Preferences ...................................................... 7
- Printing and Saving Grids ................................... 8
- Print Reports .................................................. 8
- Picklists, Lookups ............................................ 9

## DASHBOARD

- Dashboard Shortcuts Pane ................................ 11
- ProLaw section ............................................... 11
- My ProLaw ..................................................... 12
- My Actions ..................................................... 12
- Rearranging Dashboard Panes ........................... 13
  - Moving Panes ............................................. 13
  - Docking Panes .......................................... 14
  - Pinning Panes ........................................... 15
  - Resizing Panes ......................................... 16
  - Hiding Panes ............................................ 17
  - Closing Panes .......................................... 17
- Management Dashboard Graphs ........................ 18
  - Enabling Management Dashboard Graphs ........ 18
  - Viewing Management Dashboard Graphs ........ 18
  - Drilling Down on Management Graphs ............. 22
  - Saving Images of Graphs ............................... 23
  - Printing Graphs .......................................... 23
Files Preferences .............................................................................................................. 53
Transactions Preferences ................................................................................................. 56
Journals Preferences ........................................................................................................ 59
Ledger Preferences .......................................................................................................... 59
Contacts ............................................................................................................................ 60
Matters .............................................................................................................................. 61
PROLAW TOOLBAR .................................................................................................................... 62
Toggling between Dashboard and Toolbar View .............................................................. 62
Right-click Menu ................................................................................................................ 62
SEARCH VIEW .............................................................................................................................. 63
Windows-Specific Search Views ....................................................................................... 65
Quick Find View ....................................................................................................................... 65
Customizing the Search Results Grid .................................................................................. 66
Filtering Search Grids .............................................................................................................. 67
Selecting Visible Columns in Search Grids ........................................................................... 69
Grouping Search Grids ............................................................................................................ 70
Shortcuts Pane Menu Bar ....................................................................................................... 71
RECORD VIEW ............................................................................................................................. 72
Viewing Multiple Records Using the Record View ............................................................ 72
Record View Windows ...................................................................................................... 73
TOOLBARS ................................................................................................................................... 74
Customizing Toolbars ....................................................................................................... 76
PROLAW TERMS .......................................................................................................................... 77
PICKLISTS, LOOKUPS ................................................................................................................. 79
Advanced Lookups ............................................................................................................ 79
Example of an Advanced Lookup ..................................................................................... 80
Print Grid/Calendar .................................................................................................................. 81
Printing grids ............................................................................................................................. 81
Printing the Dashboard calendar ...................................................................................... 82
RECENT CONTACTS AND MATTERS WINDOW ....................................................................... 83
Defaulting the Matter or Contact ....................................................................................... 84
KEYBOARD SHORTCUTS ............................................................................................................. 85
ProLaw .............................................................................................................................. 85
Dashboard ............................................................................................................................. 85
Contacts .............................................................................................................................. 86
Dashboard ............................................................................................................................. 86
Events off the Dashboard .................................................................................................. 87
GETTING STARTED

DASHBOARD
The Dashboard is the window most users see when they first open ProLaw.

TOOLBAR
Some users prefer the traditional ProLaw Toolbar.

PREFERENCES
Dashboard preferences are user-level preferences which control Recent window, Today's Time window, and past-due reminder settings. There are also system-level settings for the appointments that display on the calendar. For more information, see Preferences.

ONEPASS SETTINGS WINDOW
For firms using Westlaw integration, each user can manage their OnePass user name and password from the Dashboard. Open the OnePass Settings window from the Tools menu. See Westlaw for more information.

RECENT WINDOW
A window which contains a list of recently-accessed contacts and matters automatically opens when ProLaw opens, provided the preference to use the Recent window is enabled. For more information, see Preferences and View Recently Accessed Contacts and Matters.

TODAY'S TIME WINDOW
A window which contains a list of your WIP and Batch time entries for the current day automatically opens when ProLaw opens, provided the preference to use the Today's Time window is enabled. For more information, see Preferences and Today's Time Window.

SEARCH VIEW
When you open an area in ProLaw such as Matters or a picklist (lookup) such as Components, the Search View for that area opens. Search for records to review, print, or otherwise manage. In many cases you can add, edit, and delete records directly in the Search View (provided you have adequate security).
RECORD VIEW

Contacts, Matters, Professionals, and other windows that contain more information than can display easily in a grid have a Record View in addition to the Search View. All of a record's details are visible on the Record view. You can also add, edit, and delete records in the Record View (provided you have adequate security).

STATUS AND PROGRESS BARS

Status and Progress bars display along the bottom of ProLaw's windows. They can appear in both Search and Record windows.

The Status bar displays both status and warning messages.

Progress bars start at 0% and display until 100% is reached (the appearance of the progress bar depends on the current Windows theme).

TOOLBARS

The toolbars that appear at the top of ProLaw windows are discussed in Toolbars.

MENUS

All the commands found in the Shortcuts pane on the search view are also available using menu commands. Menus also contain additional commands that are not found anywhere else. Each window's specific menu commands are covered in the section describing that window. For example, to learn about the menus in Transactions, read the Transactions section.

KEYBOARD SHORTCUTS

Keyboard shortcuts can be used to perform certain actions in each window in ProLaw. For example, use Ctrl+O to open a contact's or matter's record view, or use Ctrl+A to add a record in almost any window. Most windows use both standard shortcuts and shortcuts that work only in that window. For a list of each window's keyboard shortcuts, see Keyboard Shortcuts.

PREFERENCES

You can customize how ProLaw looks and behaves using Preferences.

Preferences can be accessed in either of the following ways:

- Select Preferences from the Tools menu; or
- Right-click in a window and select Preferences.

Some preferences are user-level and apply only to the window you are in. For example, each user can select whether to show the events listed on the Events tab in Matters in oldest-to-newest or newest-to-oldest order. Some preferences are user-level and apply throughout ProLaw. For example, when you customize the setting to auto-search as you type in the Quick Find view, your customizations apply to all main ProLaw windows. You cannot have one auto-search setting for Journals and a separate setting for Transactions.
GETTING STARTED

Most preferences are system-wide and can only be set by users with security to change these preferences; users who do not have the correct security will not see tabs that contain system-wide preferences. For example, system-wide preferences are used to set up Outlook and DMS integration; GL settings such as fiscal year, the retained earnings and income accounts; whether certain fields in Contacts, Matters, and Transactions are required; and so on. Preferences that are system-wide display the message: "These settings affect all users" at the bottom of the window.

ProLaw has literally hundreds of preferences. See Preferences for an in-depth discussion of each area's user- and system-level settings.

PRINTING AND SAVING GRIDS

Search results can be printed either by running a ProLaw report, or just printing the grid. If the grid does not contain all the information you need, generating an actual report is necessary. However, printing the grid is faster and easier than opening the report window, selecting the report, setting the report's parameters, and so on. Therefore, on those occasions when the grid contains all the necessary information, printing it directly is often the preferred course. Simply run the search and then press Print Grid.

See Print Grid/Calendar for information on printing and saving grids.

You can also save the search results to a file. Press the Save Grid button. A regular Save dialogue opens. Select the type of file to create and the location/name of the file. You can save the file as a web page, text file, or Excel spreadsheet.

PRINT REPORTS

The Print Reports option prints the results of searches. Unlike the print and save grid capabilities, reports can include information that does not display in the window, or exclude information that displays. ProLaw reports are customizable.

To print a report, do the following.

Find or query the records that should print. The search results should contain only the records that should print.

Click the (Print Reports) button. Under MS SSRS, the Preview window opens. Select the report from the list on the left, and right-click to preview the report. The report appears on the right, and you can set groupings and other parameters.

To print your V11 reports, select Print V11 Reports from the File menu instead of pressing the Print Reports button. A few windows (Management Reports, Check Formats, and Statement formats) don't have the File menu option. Instead, you toggle the V11 reports on from the View menu and then click the regular Print Reports button. After you have selected the menu option/clicked the button, the Run one time using current results from Search window displays. Select the report from the Report format drop-down list. Select the groupings. There can be up to four levels of groupings. The available groupings are both custom and default system fields. Select an Order by for the records to print within the lowest grouping level.

See Report, Statement, and Check Formats for more information on designing and running reports. Practice Management reports are discussed in Reports.
GETTING STARTED

PICKLISTS, LOOKUPS

See Report Shortcuts and Report Queues in Other Administrative Tasks for more information on shortcuts.

PICKLISTS, LOOKUPS

A picklist, or lookup, field, is a field that has pre-defined values. You cannot put anything you want in the field; you must select a value from a list. Users with appropriate security can add, edit, and delete items from custom and/or default picklists.

There are two kinds of lookups in ProLaw: Simple and advanced. Simple lookups have a down arrow on the right-hand side of the field, and advanced lookups have ellipses on the right. How you select records from a simple picklist is different from how you select records from an advanced lookup.

When you start typing into a simple lookup, ProLaw will auto-fill the field with first item in the list that begins with the text you are typing, and will also display the items on the list that begin with your text. You can also just click the down arrow to the right of the field to see the whole list. To fill in the field, select the desired value or simply exit the field when ProLaw auto-fills it with the correct value. If you try to type something that does not appear on the list, the field will not accept the character(s) you type. Contact class, matter billing type, and mailing lists are examples of simple lookups.

Advanced lookups do not validate what you type on the fly the way that simple lookups do. Therefore you can initially type anything you want in the field. Validation occurs when you try to leave the field: If you are permitted to leave the field, you entered a valid value. If you typed something that does not exist on the list, you will be stuck in the field and the list's search form will open with the text you entered pre-populated in Search for. Search for and select the desired record, or add a new record, and click OK to return to the window you were working in before the lookup opened. You can also just click the ellipses on the right-hand side of the field to open the lookup's search form. Any text you already entered in the field before you pressed the ellipses will be passed to the list.

More information on advanced lookups is located in Advanced Lookups. For information on maintaining simple lookups, see List Management in the Setup section in Administration.
DASHBOARD

When ProLaw initially opens, a window appears that allows you to open the various areas of ProLaw (Matters, Contacts, Transactions, etc.) You can choose whether this initial window should be the Toolbar or Dashboard.

Most people use the ProLaw Dashboard, but some prefer the traditional Toolbar. The Dashboard displays your ProLaw calendar entries for the day and allows you to add events and time entries without opening the corresponding matter, contact, or the Transactions window. It also has regular File, View, etc. menus. The Toolbar, on the other hand, is a tiny window that just shows buttons for the main areas of ProLaw. There is no calendar and no way to create events or transactions directly from the Toolbar. It has a right-click menu that serves many of the same purposes as the Dashboard’s Tools menu. You can toggle between the Dashboard and Toolbar.

The Dashboard is comprised of the Shortcut, Calendar and Reminder panes. The Shortcuts pane is located on the left. It contains links to open the various areas of ProLaw, and has buttons for executing common actions at the bottom. The Calendar Pane displays your appointments and the Reminders pane shows current and past-due ProLaw reminders. You can also access ProLaw set up items from the Dashboard’s Tools menu. The contents of the Dashboard are based on your security class and individual preference settings.

Each section of the Dashboard is discussed separately.
DASHBOARD SHORTCUTS PANE

The Shortcut pane, located in the left side of the Dashboard, consists of three sections: ProLaw, My ProLaw and Actions.

PROLAW SECTION

This section contains links to the main areas of ProLaw. These options are also available from the File menu:

<table>
<thead>
<tr>
<th>FEATURE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contacts</td>
<td>All entities with which the firm does business are stored in the same place: Contacts. Clients, vendors, related parties, billing parties, witnesses and personal contacts are all stored in Contacts. Once you enter a person or company, that contact can be attached to matters, used as a payee for checks, have cash receipts recorded from it, and more. Conflict searches are also performed from Contacts. If the contact is a client, summary financial activity for all of the clients matters can be viewed on their contact record. Docket, document, and note events for the contact can be entered here as well. Contacts reports are also created and produced from Contacts.</td>
</tr>
<tr>
<td>Matters</td>
<td>A matter is any case or action that needs to be tracked by the firm. You can also open matters to track administrative and/or personal time and project management. Summary financial activity on the matter can be viewed here. ProLaw can also be set up to perform matter-level conflict checks. Docket, document, and note events for the matter can be entered here. Contingency cases are settled in Matters. Matters reports are also created and produced in Matters. Bar code and file folder labels can be printed from here.</td>
</tr>
<tr>
<td>Events</td>
<td>This window is commonly referred to as Events off the Dashboard (or Taskbar). Dockets (appointments), documents and note events can be created in EOTD as well as from the Dashboard or on the Events tab on a matter or contact. Events searches are performed here. Events reports are created and produced here. Users who work with documents all day long are likely to benefit from using the Documents Worklist and Documents views available here.</td>
</tr>
<tr>
<td>Files</td>
<td>Refers to the physical file folders holding a matter’s documents. Check files in and out, and report on the location and status of the physical file folders. Files reports, bar code, and folder labels are created and printed from Files.</td>
</tr>
<tr>
<td>Transactions</td>
<td>Use Transactions to manage items that will be billed to clients. Create and edit time and cost entries, run cost recovery imports, create and print Transactions reports, edit pre-bills and produce statements.</td>
</tr>
<tr>
<td>Journals</td>
<td>Journals is ProLaw’s General Ledger. Enter and print checks, enter adjustments and cash receipts, perform bank reconciliations, run payroll imports, create and print GL-related reports and produce financials. All accounting functions, including trust accounting, are performed in Journals.</td>
</tr>
<tr>
<td>Ledger</td>
<td>ProLaw’s Ledger contains billing and payment history. Surprisingly, the GL is not accessed from here; that is what Journals is for. View and re-print statement images, transfer unapplied cash (retainers) among matters, refund unapplied cash, and unbill statements.</td>
</tr>
</tbody>
</table>
### Collections
Collections can be used for the practice of subrogation by law firms or for tracking debt by government agencies. In the case of subrogation, someone owes the client money, and the firm not only manages the legal matters regarding the debt but also collects the money for the client. For example, a hospital or a credit card company may engage a law firm to handle their customers who owe money. The law firm can charge a percentage of the debt collected as part of their fees. Collections can automatically create fee transactions when a debtor sends a payment so the client can be billed for the effort the firm put in to collect the money. Other transactions can also be created and the client is billed like other matters are billed.

### Reports
Also known as “Management Reports” or “Main Reports.” Most ProLaw reports are available from the specific window with which they are associated. For example, to run a Matters report, open Matters, find the matters that should appear on the report, and print the report. However, analysis and management reports such as Revenue Analysis and A/R Aging are accessed from Main Reports. Report queues and shortcuts are also managed from here.

---

**MY PROLAW**

Click the links in this section to display contacts and matters that you are associated with. The My Contacts link opens Contacts and displays contacts for which you are listed the **Personal Contact For** on the Notes tab. The My Matters link opens Matters and displays matters for which you are an assigned professional on the General tab. These options are also available from the File menu.

**MY ACTIONS**

Click one of the links in this section to add a docket, document, note, time entry or check request. A pop-up window opens that you fill out. Using this method to create events, payables, and transactions is faster than opening Contacts or Matters to the Events tab to create an event, or opening Transactions to create a time entry or Journals to create a payable.

Which of these functions is available is based on your security set up. These features can also be accessed from the Dashboard's **Actions** menu.
REARRANGING DASHBOARD PANES

The Dashboard is comprised of four panes when you first open ProLaw: Weekly Docket (or Calendar), Today's Time, Recents, and Reminders. You can rearrange these panes by moving them around the Dashboard and "dock" them (lock them into a fixed position). You can also hide panes temporarily by pinning them to the side of the Dashboard. You can also resize each pane.

MOVING PANES

To move a pane, left-click on the title bar of the pane, and then hold down the left mouse button while dragging the pane.

The pane becomes a "floating" pane, which you can position anywhere on the Dashboard. When the pane is in the desired location, release the left mouse button.
DOCKING PANES

You can "dock" or lock a pane into a fixed position on the Dashboard. To dock a pane, left-click on the title bar of the pane and move it. Four guide arrows display.

Move the pane until the mouse pointer hovers over one of the guide arrows.

Notice that the bar on the guide arrow turns light blue, and an area of the Dashboard turns light blue. Release the mouse button to dock the pane in the light blue area.
PINNING PANES

You can hide panes temporarily by "pinning" them to the sides, top, or bottom of the Dashboard. A pinned pane appears as a tab, which you can "unpin" when you want to view the pane.

To pin a pane to the side of the Dashboard, click the Pin icon on the title bar of the pane.

You can also click the Down arrow on the title bar and select Sliding.

The pane disappears and becomes a tab on the side, top, or bottom of the Dashboard.
To view the "pinned" pane, click on the tab. The pane slides into view.
To "unpin" the pane, click the Dock icon on the title bar of the pane.

RESIZING PANES
To resize a pane, position the mouse pointer on the edge of the pane. The mouse pointer becomes a double arrow.
Click and drag the edge of the pane to the desired position.
HIDING PANES

To hide a pane, click the Down arrow on the pane's title bar, and then select Hidden from the drop-down menu.

To display a hidden pane, select View > Dashboard, and then select the hidden pane from the submenu.

CLOSING PANES

To close a pane, click the Close pane icon on the pane's title bar.

To reopen a closed pane, select View > Dashboard, and then select the hidden pane from the submenu.
MANAGEMENT DASHBOARD GRAPHS

Management Dashboard Graphs provide a quick view of important financial information for your firm. Select the graphs from the View menu. The graphs display in panes on the Dashboard that you can rearrange.

ENABLING MANAGEMENT DASHBOARD GRAPHS

Before you can view the Management Dashboard Graphs, you must change the following settings:

- On the General tab of the Security Class window, select the Reports check box.
- On the Reports tab of the Security Class window, select the Management Dashboard check box.

VIEWING MANAGEMENT DASHBOARD GRAPHS

To view the Management Dashboard Graphs, select View > Management Dashboard from the menu bar. Select the graph you want to view from the submenu.

TOTAL AR GRAPH

The Total AR graph displays total Account Receivable amounts, separated by aging days. Hover the cursor over a section of the graph to view the actual dollar amount of that section.
TOTAL WIP GRAPH

The Total WIP graph displays the total dollar amounts for the transactions that have been moved from Batch to WIP, separated by aging days. Hover the cursor over a section of the graph to view the actual dollar amount of that section.

TOP 10 AR GRAPH

The Top 10 AR graph displays the matters with the ten highest accounts receivables, separated by aging days. Hover the cursor over a bar of the graph to view the matter ID, matter name, and actual dollar amount of that bar.
The Top 10 WIP graph displays the matters with the ten highest dollar amounts for transactions in WIP, separated by aging days. Hover the cursor over a bar of the graph to view the matter ID, matter name, and actual dollar amount for that bar.
GETTING STARTED

YTD HOURS GRAPH

The YTD Hours graph displays the firm's hours worked and hours billed for each month, from the beginning of the year.

![YTD Hours Graph]

TOP 10 INCOME RECEIVED GRAPH

The Top 10 Income Received graph displays the income received from the top ten highest matters.

![Top 10 Income Received Graph]
DRILLING DOWN ON MANAGEMENT GRAPHS

You can drill down for more detailed information on most of the Management Dashboard graphs. (You cannot drill down on the YTD Hours Graph or the Top 10 Income Received Graph.) After you drill down, you can run your own reports on the information displayed.

To drill down on a Management Graph

1. Select View > Management Dashboard from the menu bar.
2. Select the graph you want to drill down on from the submenu.
3. Click the Drill Down button.

The Report window displays detailed information for the Management Graph, similar to the one shown below.
SAVING IMAGES OF GRAPHS
To save a graph as an image, select Save Picture As on the title bar of the graph.

PRINTING GRAPHS
To print a graph, select Print Picture on the title bar of the graph.

USER DASHBOARD GRAPHS
User Dashboard Graphs provide a quick view of important financial information for individuals in your firm. Select the graphs from the View menu. The graphs display in panes on the Dashboard that you can rearrange.

ENABLING USER DASHBOARD GRAPHS
Before you can view the User Dashboard Graphs, you must change the following settings:

- On the General tab of the Security Class window, select the Reports check box.
- On the Reports tab of the Security Class window, select the User Dashboard check box.

VIEWING USER DASHBOARD GRAPHS
To view the User Dashboard Graphs, select View > User Dashboard from the menu bar. The four User Dashboard graphs display on the Dashboard.

FEES PER MONTH GRAPH
The Fees Per Month graph displays the amount of fees earned by the Professional for each month.
YTD FEES GRAPH

The YTD Fees graph displays the fees earned by the Professional from the beginning of the year to the current date. This amount displays at the bottom of the graph.

![YTD Fees Graph]

CURRENT WIP FEES GRAPH

The Current WIP Fees graph displays the amount of fees currently in WIP (Work-in-Process) generated by the Professional and ready to be billed. This amount displays at the bottom of the graph.

![Current WIP Fees Graph]
CURRENT AR FEES GRAPH

The Current AR Fees graph displays the current amount of Accounts Receivables generated by the professional. This amount displays at the bottom of the graph.

REFRESHING THE GRAPH DATA

To refresh the data so that the graphs display the most current data, click the Refresh button.

SAVING THE GRAPHS

To save the graphs as an image, click the Save Picture As icon.

PRINTING THE GRAPHS

To print the graphs, click the Print Picture icon.

DASHBOARD CALENDAR PANES

This pane displays ProLaw docket events (appointments) for the professionals whose dockets you have selected to display (including your own). Both Contacts and Matters events display. Double-click the event or right-click on it to view its details. The calendar can be viewed by day, work week, week and month. You can print the calendar.

Which information that is displayed for each event on the calendar is set by a system-level Dashboard Preference.

Events without event dates or professionals do not display on the calendar.
EDITING EVENTS ON THE CALENDAR

To edit an event on the calendar

1. Right-click on the event.
2. From the pop-up menu, select Edit Event. The Edit Docket window displays.
3. Change the information for the event, and then click OK.

REFRESHING CALENDAR INFORMATION

ProLaw queries current docket information when you open it. It can also be set up to automatically refresh Calendar detail at a specified interval in System Preferences. If that setting is off, or if you want to refresh the calendar before the next refresh interval, press F5, select Refresh from the View menu or click the Refresh button located above the calendar.

Refreshing the Calendar pane also refreshes the Reminders Pane.

PRINTING THE CALENDAR

The Dashboard calendar is similar to Outlook’s calendar. Calendar detail can be viewed by day, work week, week or month.

To print the calendar, do the following:

1. Select the desired view and time frame and click the Print Calendar button. The calendar can also be printed by pressing CTRL + P or selecting File/Print Calendar from the Dashboard menu.
2. A print preview screen, similar to the one that used when printing ProLaw’s search grids, displays.
3. See Print or Save Grid/Calendar for more information.

HOTKEYING TO THE EVENT

You can open the details of a docket on the calendar either by double-clicking it, or right-clicking and selecting Open Event. This opens the contact or matter to the Events tab and selects the desired event. If the docket is associated with multiple contacts or matters, ProLaw opens the first contact or matter it finds. There is no way to specify which record should be opened when you hotkey.

VIEWING OTHER PROFESSIONALS' EVENTS

Selecting which professionals’ events to view is discussed in its own section.
JUMPING TO A DATE OR DATE RANGE

You can quickly jump to a given date on the calendar by right-clicking an unoccupied portion of the calendar and selecting Go to Date. A dialogue opens prompting you for the date you wish to view. Enter the desired date and click OK. The calendar will switch to Day view if you are not already using it, and display the selected date. If you use this function you should read about all the different ways there are to enter dates in ProLaw as discussed in the Events section.

You can also select a different date using the calendar on the far right-hand side of the window.

If you highlight a range of days on the far-right calendar, the view will change if necessary and show you the selected dates. For example, if you highlight September 19th through October 16 2010, the view will change to Month and show you the selected dates. Note that if you select a range that does not fit evenly into one of the default views (for example October 20 through October 15 2010), the view will switch to a very narrow days-of-the-week view that is not normally available on the calendar.

CHANGING THE TIME INTERVAL

Right-click on the left-hand side of the calendar, where the time is displayed, to select a different time interval:
VIEW OTHER PROFESSIONALS' DOCKETS (DASHBOARD CALENDAR)

When you open ProLaw for the first time, only docket events to which you are assigned display on the Dashboard. You

To manage which professionals’ events appear on your calendar:

1. In the Calendar pane, click the Select Professionals button.
2. The Select Professionals window opens:

   ![Select Professionals](image)

   By default, the events for the current user will display in the calendar. To exclude yourself from the list of professionals whose events display on the calendar, uncheck the Include current user check box.

3. Click the Add button to create a row.
4. Enter the desired professional's initials. You can also click the ellipsis button to access the Professions list and double-click the professional you want to add. Only active professionals can be selected.
5. To stop viewing a professional's events, select the row for the unwanted professional and press the Delete button. A confirmation appears asking you if you really want to remove the professional from the grid.
6. Click the Ok button to return to the Dashboard.

   Note: Events will appear only once, even if multiple professionals are assigned to them.

   Note: If an event uses item-level security and you are not in the event's View group, you will not be able to see the docket.
DASHBOARD REMINDERS PANE

This pane displays under the Calendar, to the right of the Shortcuts Pane. It shows the day's ProLaw reminders for the docket events on your calendar. Reminders are displayed for all the professionals whose appointments you have selected to view.

For events dated today or in the future, only reminders set for the current date appear. They display in black.

This pane will also display past due events if the user-level Dashboard preference to display past due reminders is on. Past due events are docket events that are uncompleted and their date occurred in the past. For example, if today is October 3, 2012 and you are assigned to a docket event dated September 26, 2012 that does not have the Done Date filled in, that event will appear here even if it does not have any reminders. Past due reminders display in red.

The Reminders Pane is refreshed the same way the Calendar Pane is. You can also hotkey to the event the same way you hotkey to Calendar Pane dockets via either double-click or right-click.

A past due reminder and a regular reminder can display for the same event.

The Reminder Pane's grid columns can be moved and resized, but you can't select visible columns. Event Date, Reminder Date, Event Description, Initials, and contact name/company or matter ID/description always display.

DASHBOARD MENUS

FILE MENU

Contacts, Matters, Events, Files, Transactions, Journals, Ledger, Reports, My Contacts and My Matters are the same options as appear in the Shortcuts Pane and are discussed in that section.

Print calendar prints the currently-viewed calendar as discussed in the Calendar Pane section.

VIEW MENU

Refresh: Refreshes the calendar and Reminder panes.

Toolbar: Toggles to the ProLaw Toolbar.

ACTIONS MENU

This menu is comprised of options to create different kinds of ProLaw records. You can add a docket, document, note, time entry or check request. The same options appear here as appear in the Actions section of the Dashboard's Shortcuts Pane.
HELP MENU

Help opens the help files.

About: Opens the About window that displays the ProLaw version, edition and current user's Windows login.

TOOLS MENU

The Tools menu has several system maintenance options and is discussed in Setup.

RIGHT-CLICK MENUS

The right-click menu changes somewhat depending on exactly where in the Dashboard you right-click.

The right click menu usually contains the options to open Dashboard Preferences, Open Recent window, and Open Today's Time window. You enable the latter two in the former. It also usually contains the OnePass Settings option provided that Westlaw integration is enabled in System Preferences.

If you right-click on an event in the Calendar or Reminders pane, there is an option to open the event. The Calendar Pane's right-click menu contains options to jump to the current date or another date. You can also change the time interval the calendar displays by right-clicking in time interval area. The calendar that displays to the far right of the Calendar Pane has no right-click menu.

DASHBOARD TOOLS MENU

Many system maintenance tasks are accessed from the Tools menu located on the Dashboard. Which options appear depends on your security class.

Query Definitions: Manage Query Definitions. Covered in Other Admin Tasks.

Setup reports: Run reports for custom or default picklists, or for queries saved in any of your query libraries (query library queries are created in the Save Query window accessed from Matters, Contacts, etc.) Appears if you have Setup reports selected in your security class.

Setup: Opens many of ProLaw lists such as Area of Law, Components, etc. This submenu does not appear if you do not have Change Setup security for Matters and also do not have Administrator security. If you have one of them selected, the menu does appear. For the most part, which of the below options you can see is based on your security. If you don’t have Change Setup security to the window that uses the list in question, then generally list does not appear in your Dashboard Setup menu.

- Accounts: Opens the GL chart of accounts. If you have the Setup submenu, Accounts will appear, even if you do not have any Journals security at all. It is not editable if you do not have security to Change Accounts in Journals security, and which accounts appear in the list can also be limited by Journals security.

- Components: Opens the list of types of charges assigned to transactions. Visible if Change Setup is checked in Transactions security. Covered in Setup.
GETTING STARTED

- **Rates**: Opens the Rates list, which is covered in Billing Setup. Visible if **Change Setup** is selected in Matters security.

- **Docket Types/Document Types/Note Types**: Visible if **Change Setup** is selected in Matters security. Open the event type lists. Covered in separate Docket Types, Document Types, and Note Types sections in Setup.

- **Professionals**: Opens Professionals, discussed in Setup. Visible if **Change Setup** is selected in Matters security.

- **Rules**: Opens the list of custom and WLCR rules as discussed in Setup. Visible only if your security class has **Change Setup** in Matters selected.

- **Security Groups**: Not to be confused with Security Classes, which contain all of ProLaw’s security settings, this option opens the list of item-level security groups. Visible only if item-level security is enabled and you have security to **Change security group setup**. Covered in the Security spec.

- **Security Classes**: Opens the list of ProLaw security classes which contain all the security settings for the various windows in ProLaw. Not to be confused with Security Groups which are for item-level security. Visible only if your security class has **Administrator** selected on the General tab in Security Classes.

- **Licensing**: Opens the Licensing window, discussed in its own section in the Setup section in Administration. Appears only if you have security to change system preferences.

- **System Preferences**: Opens the System Preferences window, discussed in Preferences. Naturally, this option also does not appear if you do not have security to change system preferences.

- **Report Setup**: Opens the Report Setup window, discussed in Report, Statement and Check Formats in Administration. Appears only if you have security to change MS SSRS Setup.

**Matter Conflict Votes**: Opens the conflict review window, discussed in Matter Conflicts.

**Dashboard Preferences**: Opens Dashboard Preferences, discussed in Preferences.

**OnePass Settings**: Set ProLaw to use your current OnePass password. Appears only if Westlaw integration is enabled in System Preferences.

**Open Recent window**: Opens the list of recently-accessed contacts and matters. Discussed in Getting Started.

**Open Today's Time window**: Opens a window that displays all of your time entries for today. Discussed in Transactions.
Preferences provides the ability to set up various ProLaw features for an individual user or all users (globally).

In each area are settings that are under the control of the individual user. These are the settings you can change without impacting any other ProLaw users. To get to the preferences of a given area, just right-click anywhere on the window and select Preferences from the pop-up menu. Alternatively, select Preferences from the Tools menu.

Most Preferences windows have a Search tab.

Auto-search after pause in Find: When text is entered into the Search For field on a typical Find view, ProLaw searches for matches that begin with the entered text as soon as you pause typing. Turn this feature off by disabling the check box next to Auto-search after pause in Find. When this feature is disabled, it is necessary to click the Start Find button after entering a value in the Search For field in order to execute the search.

It is also possible to control what ProLaw interprets as a pause. The default is set to 7/10ths of a second. If you want a full second delay in your typing before ProLaw auto-searches, change that value to 10.

Changing auto-search settings in one area changes it in all areas. In other words, it is not possible to have auto-search on in Matters but off in Transactions. The one exception to this rule is Bank Reconciliation: Whether or not to auto-search in that window is a user-level setting located in Journals Preferences.

Open record form to first tab: This option is also system-wide and appears even in the Preferences for areas that do not have record forms like Transactions and Journals. It controls whether the record form for a given area (Matters, Contacts, Files) or advanced lookup (such as docket types) opens to the first tab, or to whatever tab you had selected the last time you had the window open. For example, if the preference is off and the last time you opened a matter record form you had the Inquiry tab open, the next time you open a matter record, the Inquiry tab will be selected. This applies to hotkeying and opening the record form from the Search view. When you page through the record forms of your search results using the navigation buttons, you always see whatever tab you had selected on the last record you viewed. If for some reason the last-viewed tab does not exist on the current record, for example you last viewed a custom tab on a contact but the next contact you open has a class that cannot see that custom tab, the record form opens to the next visible tab.

In addition to the search and record form options, there are a few other options that are user specific. Which options appear change depending on which window’s preferences you are viewing (Matters, Contacts, etc.)
CONTACTS USER PREFERENCES

SEARCH TAB

Auto-search after pause in Find: Enable or disable automatic searching on the Find tab as discussed in the Search Tab section above.

Open record form to first tab: Designate a record view to always display the first tab or the tab that was selected when the record was last open as discussed in the Search Tab section above.

Limit most recent list to X contacts: Sets how many contacts displays on the Recent view. 10 is the default; if it is preferred that the last 20 contacts that you edited are listed, change the setting to 20.

Exclude requested status types in Find: The administrator can set up contact statuses, such as "inactive", to be excluded from the Find view. The contacts displays in query results if they meet the query criteria, but they can be excluded from the Find view so that the screen is not cluttered with inactive contacts.

Document icons for event tree: Select whether to view ProLaw's traditional document icon on document events in the tree on the Events tab, or the file type icons recognized by your computer's operating system. There are separate settings for the Matters and Contacts events tabs. Defaults to file type icons.

There are also some settings in Matters preferences that control how the Events tab displays in both Contacts and Matters.

OPTIONS TAB

On the Options tab, you can determine the address format used when you click Copy Address Block. The format determines whether the company or contact name is on the first line and whether the title is included. The function of Copy Address Block (copies the contact's address to the workstation's clipboard) is covered in Contacts.
MATTERS USER PREFERENCES

SEARCH TAB

**Auto-search after pause in Find:** Enable or disable automatic searching on the Find tab as discussed in the Search Tab section above.

**Open record form to first tab:** Designate a record view to always display the first tab or the tab that was selected when the record was last open as discussed in the Search Tab section above.

**Exclude requested status types in Find:** Works the same way as the Contacts preference but is based on the matter status field. The two preferences are independent. In other words, setting it in Contacts does not affect Matters.

**Limit most recent list to X matters:** How many matters display on the Recent view is set here. It is independent of the analogous preference in Contacts.

**Confirm docket dates in the past (applies to the pop-up Create Docket window only):** Select this check box to have ProLaw display a confirmation message when you enter a date on a docket event that is earlier than the current date. This preference applies only when creating dockets using the pop-up window, for example, from the Dashboard or Events off the Dashboard. If creating docket events on the Events tab in Matters or Contacts, the message that the docket date is in the past displays in the bottom left status bar of the window and cannot be hidden. This preference does not apply to note or document events. It applies to parent docket events only. You will not be prompted if the event being created is a child event, a recurring event, a Create When Done event, a copied event, a docket with a linked document or an event with no date at all.

**Events Tree options**

**Show notes in Events tree:** The tree on the left hand pane of the Events tab can show either the event type or the first line of event notes. Check this box to see notes rather than event type. This setting controls the Events tab in both Contacts and Matters.

**Include uncompleted events before "go back" date:** If using a date filter on the Events tab, this setting controls whether uncompleted dockets are also excluded by the filter. This setting controls the Events tab in both Contacts and Matters.

**Show most recent events first:** The default display order on the Events tab is oldest to newest. If it is preferred to see the events newest-to-oldest, check this box. This setting controls the Events tab in both Contacts and Matters.

**Document icons for event tree:** Select whether to view ProLaw’s traditional document icon on document events in the tree on the Events tab, or the file type icons recognized by your computer’s operating system. There are separate settings for the Matters and Contacts events tabs. Defaults to file type icons.
GETTING STARTED

PREFERENCES

EVENTS USER PREFERENCES

FULL TEXT INDEXING

Auto-search after pause in Find and Open record form to first tab: Discussed in the Search Tab section above.

- **Fuzzy**: Finds a word even if it is misspelled. For example, a fuzzy search for "apple" finds "appple." Fuzzy searching is particularly useful when searching OCR'ed (scanned) documents.

- **Phonic**: Looks for words that sound like the word you are searching for and that begin with the same letter. For example, with phonic searching turned on, a search for "Smith" also finds "Smythe". Phonic searching increases search time.

- **Stemming**: Extends searches to include grammatical variations of a word. For example, a search for "fish" also finds "fishing."

- **Synonyms**: Finds words that mean the same thing as the word for which you are searching. For example, a search for "fast" also finds "quick."

- **Related Words**: Finds words related to your search as described below.
  - **Antonyms**: Words that have the opposite meaning from the words that you entered.
  - **Hypernyms**: Things that are subcategories or subitems of the word that you entered.
  - **Hyponyms**: Categories that the word you entered belong to (the opposite of a hypernym).
  - **Meronyms**: Something that is a part of or a member of the word that you entered.
  - **Holonyms**: Something that the word you entered is a member or part of.

The "Synonyms" and "Related Words" options require the optionally installed ProLaw Thesaurus.

- **Limit matches**: Limits the matches to the specified number. For example, if you are looking for some very common text, you may only want five or six examples of it. However, when you are performing a full text search, you also have the option (in a drop-down) to specify a time frame, thereby ensuring that you get the most recent examples of a document. The time-frame drop-down is a more effective means of limiting your full text searches.

OPTIONS TAB

Default file name for e-mailed documents

Use the options on this drop-down list to set the default naming convention for documents attached to e-mails.

- **Document Number**: The number that ProLaw assigns to the document; the actual filename.

- **Event Note (first line)**: Renames the attachment using the first line of the related event's Notes field. The first line is defined as either the first 70 characters, or up to the first hard return, whichever comes first.

- **Event Type**: Changes the file name to the associated event type.

Note: When sending an e-mail with an attached document, you will have the option of changing the file name from the default.

Automatically check out document on Load

This preference is only available when ProLaw Document Server is enabled.

When this check box is selected, the **Load Document** button will check the document out just like **Check Document Out** does. If this option is not selected, **Load Document** opens the document but does not check it out, and therefore the document opens in read-only mode.
If ProLaw Document Server is not being used, the Load Document button opens documents for editing.

FILES USER PREFERENCES

Users can specify if the list of files used by the mass check-in/out feature defaults to the previous list used, the current query, or the current record.

If "current query" is selected and you check in/out from the Search form, the check-out list will be populated from the full query results. However, if you check in/out from the Record form, the list will contain only the current record.

TRANSACTIONS USER PREFERENCES

The Options tab in Transactions Preferences has user-specific preferences relating to the timer.

- **Timer demonstration**: While you are experimenting with the Timer, you can enable this feature. This allows you to quickly see how the timer functions under various circumstances without having to waste your precious time. However do not leave this feature enabled for your real time entry!
- **Automatically start timer on new transactions**: Starts the timer ticking whenever you start a new transaction. This preference applies to transactions created on the Time Entry view and time entry pop-up window. It does not apply to transactions created in the Quick Find view.
- **Set timer to manually entered units**: If you enter units, the timer uses that as the start time.
- **Restart timer at rounded up units**: When you leave a transaction, return to it and start the timer, it rounds up the units based on the setting on the Settings tab.
- **Component**: Select the component you use most often when entering transactions. A fee or a cost component can be selected. The default component for new transactions is determined in the following fashion: Use the user-level default component specified here. If no default is entered here, use the system-level default component. If there is no system-level default either, the component on new transactions defaults to the component on the transaction that was selected when you pressed the *Add* button. If no transaction was selected, the default component will be T. If no component with the id T exists, then component is blank. If the transaction is a hard cost entered on the Transactions tab in Journals or Check Request, use the vendor's default component, not the user's or system-level default. If the vendor has no default component, leave component blank.
- **Time Entry pop-up window settings**: Select to automatically open the Time Entry window when performing any of the below actions. The Time Entry window will open only if you have security to change batch transactions. If you do not have security to perform a certain action, that action's setting is disabled. For example, if you do not have security to open Files, the option to track time when viewing a file is disabled. Further, if your firm is using timekeeper licensing, auto-track time applies only to active timekeepers. The Time Entry window will never open automatically for non-timekeepers and the user-level Transactions preferences are not available to non-timekeepers. (Any active professional with appropriate security can use auto-track time under seat licensing.) These user-level settings can be overridden by the administrator. If the administrator has set the corresponding system-level options on the Time Entry Window tab in Transactions Preferences, the user-level options discussed here are selected and disabled. The fact that the system-level settings override the user-level settings is very rare in ProLaw; usually it's the other way around. For more information on auto-tracking time, see Auto-track Time in Transactions.
  - **Auto-track time when viewing a matter**: The Time Entry window will open when you open a matter's record view.
  - **While viewing a file**: The Time Entry window will open when you open a file's record view.
• **Pro Filing settings**: If Pro Filing is enabled in System Preferences, you can also elect to auto-track time when opening a file in a Pro Filed application. The Time Entry window will open any time a file in that application is opened, whether you open the file from the Events tab, EOTD, or directly in the application. These options are disabled if Pro Filing for the application is off.
  
  ▪ **Opening a document in Word**: The Time Entry window will open any time a Word document is opened.
  
  ▪ **Opening an e-mail in Outlook**: The Time Entry window will open any time an e-mail is opened.
  
  ▪ **Opening a document in Adobe**: Same as above, but for Acrobat and Reader.
  
  ▪ **Opening a spreadsheet in Excel**: Same as above, but for Excel.

**USER ABBREVIATIONS**

Users can also make their own personal abbreviations to facilitate time entry. Abbreviations work in every notes field, so they can facilitate more than just time entry. Enter the abbreviation in the Abbreviation column and the text that it represents in the Text column. When you enter the abbreviation in any notes field in ProLaw and press the space bar (or put in a period), the abbreviation is automatically translated to the specified text. Abbreviations that everyone uses should be entered on the regular Abbreviations tab in Transactions Preferences.

**JOURNALS USER PREFERENCES**

On the Search tab in Journals Preferences, specify whether or not to include only vendor contacts when looking up payees. When this is enabled and the user is entering a check, the Contacts list only displays contacts that have a class that begins with Vendor.

Whether or not to auto-search in Bank Reconciliation is also located here.

**LEDGER USER PREFERENCES**

There are no additional user preferences in Ledger.

**DASHBOARD AND TOOLBAR PREFERENCES**

Use the following options to set up ProLaw to display important additional information on when accessing the Dashboard and to hide or display optional windows for both Toolbar and Dashboard users.

**ACCESS DASHBOARD AND TOOLBAR PREFERENCES**

To access ProLaw's Dashboard preference settings, select **Tools/Dashboard Preferences** from the main Dashboard menu or right-clicking on the Dashboard and select **Dashboard Preferences** from the pop-up menu. If the Toolbar is used, right-click on the toolbar to open the applicable set of preferences.
OPTIONS TAB

Include uncompleted events in reminders that are X days old

Displays a row in the Reminders pane for each uncompleted docket event assigned to a user whose events you are viewing where the event date is in the past. Uncompleted events up to a year old can be displayed; 30 days is the default.

CALENDAR SETTINGS TAB

The system-level preferences on the Calendar Settings tab in Dashboard Preferences control the descriptions of the events that appear on the Dashboard. The Contact events description calculation applies to events that belong solely to contacts. The Matter events description preference applies to matters-only events and events that are for both contacts and matters.

ProLaw comes with several default calculations. Custom calculations can also be created. Contact ProLaw Client Services for assistance with custom calculations.

Contact Events Description Definitions

<table>
<thead>
<tr>
<th>CALCULATION</th>
<th>RESULT</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONCATWITH(' ', CONTACTLINK(CalendarQuery.Contacts, 'Last, First'), ADDPARENS(CalendarQuery.CompName))</td>
<td>Contact last name, first name (contact company)</td>
</tr>
<tr>
<td>CONCATWITH(' / ', CONCATWITH(' ', CONTACTLINK(CalendarQuery.Contacts, 'Last, First'), ADDPARENS(CalendarQuery.CompName)), CalendarQuery.ContactClass)</td>
<td>Contact last name, first name (company) / contact class</td>
</tr>
<tr>
<td>CONCATWITH(' ', CalendarQuery.CompName, ADDPARENS(CONTACTLINK(CalendarQuery.Contacts, 'Last, First'))</td>
<td>Contact company (contact last, first name)</td>
</tr>
<tr>
<td>CONCATWITH(' / ', CONCATWITH(' ', CalendarQuery.CompName, ADDPARENS(CONTACTLINK(CalendarQuery.Contacts, 'Last, First'))), CalendarQuery.ContactClass)</td>
<td>Contact company (contact last, first name) / contact class</td>
</tr>
</tbody>
</table>
Matter Events Description Definitions

<table>
<thead>
<tr>
<th>CALCULATION</th>
<th>RESULT</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONCATWITH(&quot;&quot;, CalendarQuery.ShortDesc, ADDPARENS(CalendarQuery.MatterID))</td>
<td>First line of the matter description and (Matter ID)</td>
</tr>
<tr>
<td>CONCATWITH(&quot;&quot;, CalendarQuery.ClientSort, ADDPARENS(CalendarQuery.MatterID))</td>
<td>Client sort and (Matter ID).</td>
</tr>
<tr>
<td>CONCATWITH(&quot;::'EventInitials', CONCATWITH(&quot;/&quot;, CalendarQuery.ClientSort, CalendarQuery.MatterID))</td>
<td>Event professional initials: client sort / Matter ID</td>
</tr>
<tr>
<td>CONCATWITH(&quot;&quot;, CalendarQuery.MatterID, ADDPARENS(CalendarQuery.ShortDesc))</td>
<td>Matter ID and (client sort).</td>
</tr>
<tr>
<td>CONCATWITH(&quot;&quot;, CalendarQuery.MatterID, ADDPARENS(CalendarQuery.ClientSort))</td>
<td>Matter ID and (first line of the matter description).</td>
</tr>
<tr>
<td>CONCATWITH(&quot;::', CalendarQuery.MatterID, CONCATWITH(&quot;/', CalendarQuery.ShortDesc, CalendarQuery.EventDesc))</td>
<td>Matter ID: first line of the matter description / Event Type</td>
</tr>
</tbody>
</table>

SYSTEM-WIDE SETTINGS AND PREFERENCES

The only users that can change system-wide settings are those who have a security class with Change system-wide preferences enabled. Users with the right security can change the system preferences found both in the System Preferences accessible from the ProLaw Dashboard and the system-wide settings found in each area.

SYSTEM PREFERENCES

Select System Preferences from the Tools menu on the ProLaw dashboard.

GENERAL TAB

- **Use item security in Use item security in Contacts, Matters and Events:** Item-level security allows you to determine who can view, edit or change a given contact, matter, event or event type. You must be the only person in ProLaw to successfully turn this setting on. You can read more about item-level security in the Security section.

  Item-level security is also used to determine whether the portal can be used, so if you're implementing the ProLaw Portal, you must turn this setting on. Use Portal security (see below) to limit the records that can be viewed by individuals via the portal, but enable item-level security so the portal can be used at all.

*Note:* You do not have to enable item-level security (ILS) in order to restrict users from seeing certain reports. ILS is only necessary if you want to restrict users from seeing certain events, matters, and/or contacts (or to use the portal); security groups can be used in reports even when ILS is off. For more information on limiting reports to specific groups, see Assigning Security Groups to Reports.
• **Matters/Contacts item security applies to corresponding Events tab**: Select this check box to prevent users who are not in the matter or contacts Change group from manipulating events for the matter/contact. Refer to Security for further details on Item-level Security.

  **Note**: When this option is not selected, users who are not in the matter's/contact's Change group can add events for it.

  **Note**: If an event is associated with another matter or linked to a contact, this preference will not prevent users from manipulating it there. This setting will also not prevent users from seeing the event in Events off the Dashboard. In order to prevent users from seeing an event everywhere, set item-level security on the event itself.

• **Enable Portal security in Contacts, Matters, and Events**: If the ProLaw portal will be used, check this box. Each contact matter and event can be assigned portal security groups, similar to the way item-level security works.

• **Use ProLaw Document Server**: Select this check box to use ProLaw Document Server. The Document Server must be installed separately; this preference just makes ProLaw recognize that it is installed.

• **Beep on status messages (non-warning messages)**: System beeps when non-error messages display (such as when you docket something on a weekend). This sound reminds users to look at the status bar of the current window to see the message.

• **Find professionals by ID instead of initials**: Allows you to assign professionals to contacts, matters and events by the value in the professional ID field rather than by initials. Only applies to contacts, matters, security groups, and events. Does not apply, for example to transactions.

• **Allow /userid**: If disabled, users cannot open ProLaw as another professional using the /userid= switch on the ProLaw shortcut.

• **Allow PDF conversion of documents and e-mail attachments**: In order to save ProLaw documents and e-mail attachments in PDF format, a file called PDF Xchange Pro needs to be installed at the user workstation. When this preference is selected, ProLaw will attempt to install PDF Xchange Pro when a user launches ProLaw for the first time on their individual workstations. PDF Xchange Pro installs a printer on the workstation. The printer is named PDF Xchange Pro. If this printer is deleted or renamed, ProLaw documents cannot be converted to PDF. For more information, see Installing the PDF Conversion Software in Installing ProLaw.

  **Note**: The user will need administrative rights to the workstation in order to install PDF Xchange Pro. Once it is installed, it can be used with normal user permissions. Once PDF Conversion is enabled, the PDF buttons in ProLaw and check box in e-mail attachments will be enabled.

• **Create recurring events through X years**: Check this box to specify the number of years out ProLaw should create recurrences. ProLaw also displays the years through which recurring events have been created (if any).

• **Country**: This setting is used to determine the field captions and query terms in some windows. For example, it is used to appropriately use "check" or "cheque," "area of law" or "practice area," "ZIP code" or "Postal code." This preference is primarily of use to our Canadian clients.

• **Set ADO Command Timeout to X seconds**: If you have a large database and queries time out before they return results, or there are connection problems on your network for some reason, set this above the default 30 seconds. Any timeout errors that users see in ProLaw should go away if this setting is high enough.

• **Refresh Dashboard queries every XX seconds**: Select this check box to configure ProLaw to periodically refresh the information displayed in the dashboard Calendar and Reminder panes. Enter the interval between query refreshes in the Seconds field or use the field's arrows to adjust the time. To manually refresh the dashboard, press F5, select Refresh from the View menu or click the Refresh button located above the calendar.)
• **Change database password:** If you would prefer to change the password to the ProLaw database in ProLaw rather than directly in SQL server, press this button. Note that if the password is lost, ProLaw Support is not able to supply it.

**AGENT SCHEDULE**

Select tasks for the ProLaw Agent (sometimes referred to as the Report Agent) to run, when the tasks should be run, and other settings specific to each task.

For more information on setting up the ProLaw Agent, see Other Administrative Tasks.

**AGENT LOG**

Displays history detail of the ProLaw Agents tasks (i.e., when the task was run, what the task was, and whether it succeeded or failed).

**WESTLAW TAB**

The Westlaw tab allows you to turn on various parts of the Westlaw integration. Westlaw integration helps you look up people, companies, and rule citations while automatically tracking the time spent on research for easy billing.

**Enable Westlaw integration:** Westlaw integration cannot be used if this box is not selected.

Select the databases to use when performing Westlaw searches

**Edit field mappings:** For each selected database, the ProLaw fields can be mapped to Westlaw fields for both contacts and matters.

**PRO FILING TAB**

Use the options on this tab to configure Pro Filing settings for contact- and matter-related documents.

• **Pro Filing for Adobe Acrobat** - Select this check box to enable Pro Filing for Adobe Acrobat and Adobe Reader. For information on using Acrobat Pro Filing, see PDF Pro Filing.

• **Default docket type for Outlook appointments** - Enter or select a default docket type to assign to docket events created from Outlook appointments. Applies to Pro Filing only. Tasks do not have a default docket type. You can only select a docket type that is marked for use in both Contacts and Matters and to send to Outlook as an appointment, and does not have a rules set or area of law limitations assigned.

• **Default e-mail type for Outlook e-mails** - Enter or select a default document type to assign to e-mail events created from Outlook. Applies to both Pro Filing and Outlook View integration. You can only select a document type that is marked for use in both Contacts and Matters and does not have a rules set or area of law limitations assigned.

• **Default document type for Outlook attachments** - Enter or select a default document type to assign to Pro Filed e-mail attachments. Applies to both Pro Filing and Outlook View integration. An empty or blank document type is usually used. You cannot select a document type that is assigned to a rules set or has AOL limitations.

If you want to automatically track time when files in these applications are opened, select the appropriate options in Transactions Preferences. See Auto-track Time in Transactions for more information on auto-tracking time.
CONTACTS PREFERENCES

FIRM TAB

- **Firm Contact**: You want to create a contact for the firm for use in reports and statement formats. The firm contact is also used as the payee when automatic trust application creates checks for the firm. If you use the firm contact fields in report and document type design, in the unlikely event that the firm’s name, address, or phone number changes you only have to update one contact record instead of numerous statement formats and document types.
- **Default status**: New contacts will automatically have the status field on the General tab be filled in with the value entered here. It can be changed if desired.
- **Confirm changes to full name**: If checked, when users change the full name field a box will pop up asking if they’re sure.
- **Show Events tab in Contacts and Contacts tab in Events**: If checked, the Events tab in Contacts will be visible and contacts events will be accessible in Events off the Dashboard. If this box is not selected, Pro Filing will be available only for Matters events, not Contacts events. If this box is not checked, the Create Docket, Create Document, and Create Note windows accessed from the Dashboard will allow only Matters events to be created, not Contacts events. If your firm does not use events in Contacts, clear this checkbox.

CONFLICTS

- **Do contains searches**: When you search in conflicts, it looks for any name that begins with the data you have typed in the conflicts search window. If you check this option, conflicts looks for any name that contains the data you have entered in the conflicts search window.
- **Phonic Searching**: Phonic searching looks for names that sound the same, even if they are spelled differently (as long as they start with the same letter) using a technique called Soundex. Phonic searches are slower than regular conflicts searches and you cannot search the notes field or use contains searches while using phonic searching.
- **Search contacts notes**: The notes field on the Notes tab in Contacts is an excellent place to enter AKA information. Turn on this option and that AKA information is included in the conflicts search. This option does not search any custom notes fields you have created.
REQUIRED FIELDS

Mark the fields in this grid that users must enter when adding a new contact. For fields on custom tabs, make sure your custom tabs are limited to only display for the correct contact class. Then the required fields on a custom tab only apply to contacts with that contact class. Required fields are covered in more depth in Required Fields later in this topic.

DOCKET

**Email subject line calculation:** What displays in the subject line of e-mails and appointments sent from Contacts. Works just like the analogous field in Matters Preferences, except that the calculations that work in Contacts events are different from those that work for Matters events.

DOCUMENTS

**Subdirectory scheme:** ProLaw stores documents created in Contacts using the values selected here. Works just like the analogous field in Matters Preferences except Contacts-specific fields are available.

MATTERS PREFERENCES

Matters preferences that relate to DMS integration can be found in the Document Management Integration section.

Matter preferences that relate to e-mail integration with Outlook can be found in the Outlook Integration section.

To auto-track time when opening a Matters record, select the appropriate option in Transactions Preferences.

MATTER ID

- **Matter ID Type:** Select how you want to assign the Matter IDs from the drop-down list.
  - Manually Assign: This means you type it in every time.
  - Incrementing Matter ID: Assigns a four-digit number which increments by one for each new matter.
  - Incrementing Client and Matter IDs: Client ID increments by one for each new client and the Matter ID increments by one regardless of who the client is. For example, if you have Matter IDs 1001-001, 1001-002 and 1001-003 and you open a matter for a new client, ProLaw assigns 1002-004 as the Matter ID.
  - Incrementing Client IDs, Matter ID Incrementing Within Client: Client ID increments by one for each new client and Matter ID increments by one for each matter for that client. For example, if you have Matter IDs 1001-001, 1001-002 and 1001-003 and you open a matter for a new client, ProLaw assigns 1002-001 as the Matter ID.

- **Next client ID:** Specifies the next client ID. Use the increment by field to specify the interval by which you are incrementing.

- **Next matter ID:** Specifies the next matter ID is. Use the increment by field to specify the interval by which you are incrementing. Use the Starting at field to select the starting matter ID for each client. This field is only active when you have "Incrementing Matter ID" selected as the Matter ID type.

- **Matter delimiter:** Specifies the delimiter between the client ID and matter ID.
- **Submatter length**: When you create a submatter, ProLaw takes the current matter ID and appends a period followed by a suffix. This value determines the length of that suffix. For example, if the value is 3 and the current matter ID is 1001-001 and you make a submatter, the submatter ID is 1001-001.001.

- **Submatter delimiter**: Specifies the delimiter for sub-matters.

- **Next pending ID**: When new matters are opened with a status of "Pending," they receive a matter ID that begins with PENDING and the number specified in this field. This preserves the valid matter IDs for matters that clear conflicts. When you change a matter's status from Pending to Open, the matter is automatically assigned a normal matter ID. If you change a matter's status from Pending to Declined, the matter ID is changed to DECLINED rather than PENDING, and the same pending number is used.

- **Matter ID calculation**: This is intended to augment the selection for matter ID type, not replace it. For example, perhaps you want the matter ID to begin with the last two digits of the year it is opened. You would create a calculation that adds the year to the matter ID. Conveniently, ProLaw has included this calculation as a default. Here is a list of the default calculations and what they do:
  - **MattersQuery.MatteridSort**: The matter ID sort is a value tracked in ProLaw that is never seen. It is the matter ID with both the client ID and the Matter ID padded to 6 places. So if the matter ID is 1001-001 if ProLaw assigned it, the matter ID sort would be 001001-000001. So if you really like to see all those extra place holder zeroes, you can.
  - **select('Select Right(''' + MattersQuery.OpenedDate + ''', 2) as myfield') + '-' + MattersQuery.MatterId**. This one adds the last two digits of the year in which the matter was opened to the front of the matter ID.

- **Short increment the first matter after –001**: If you are incrementing your Matter IDs by 5 and you start at 001, you do not really want the next Matter ID to be 006. You probably want it to be 005. You should check this box.

- **Prefix matter segment with year opened**: Puts the year in front of the matter part of the matter ID. For example, the first matter opened for client 1020 in 1999 would be 1020-1999001.

- **Prompt for client ID when it’s ambiguous**: When you open a matter for an existing client and they have matters that have different client IDs you are prompted to select one of those existing IDs or create a new one.

- **Always prompt for client ID**: When you open a matter for an existing client you are always prompted to select an existing client ID or create a new client ID.

- **Append client ID to client sort**: Adds the client ID in parentheses to the end of the client sort.

- **Confirm changes to matter ID and client sort**: This is good thing to enable. If someone changes a matter ID or client sort, they receive a confirmation box just in case they did not really mean to change it.

- **Client ID Position/Matter ID Position**: If you are using a matter calculation, specify what part of the whole matter ID represents the client (Client ID Position) and what part represents the matter (Matter ID Position).
CONFLICTS

You must fill out these preferences in order to use Matter Conflicts. The grid displays a list of the fields in Matters that you can use in your matters-level conflicts check. All custom fields are included.

- If you mark the Auto-Fill box, the information in that field for the current matter is included in the search window.
- If you mark the Search box, that field in the other matters is searched when the conflicts check is conducted.
- Auto-fill voting when adding a matter: Professionals who are marked as Conflict Voters are automatically added to the Conflict Review tab when you add a new matter. This is useful when the same group of professionals review all pending matters. If that is not the case, do not check this box. You need to select the people who should vote on a new matter when you open the matter.
- Auto-fill search by when adding a matter: Values in the fields that are marked as Auto-Fill in the grid are actually auto-filled into the search by when you add a matter. This option saves you the trouble of having to open Matter Conflicts and click Auto-Fill to populate the Search By.
• Auto-fill cascade fields when running conflicts: If you have included any cascaded field in the auto-fill or search portion of the conflicts preferences, make sure you enable this box. Otherwise you spend all your time clicking OK on include dialog boxes to tell ProLaw what entries on the cascade you want to use in conflicts searches.
• Contains searching: Searches for the word anywhere in the field, not just at the beginning.

DEFAULTS

• **Status**: Specify the default status of newly opened matters. If you are going to use the matter-level conflicts checks, you should make the default status Pending. Matter-level conflict searching is only available on Pending matters. Otherwise, you want to set the default status to "Open.

The firm determines the Status picklist. Some recommendations include, but are not limited to:

<table>
<thead>
<tr>
<th>STATUS OPTION</th>
<th>PURPOSE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed</td>
<td>Use when the matter has been concluded. All financial transactions are completed. There can be no WIP, batch, transactions, A/R, unapplied cash or trust balances when closing a matter. When a matter's status is changed to Closed, mark as completed any open events for the matter. Be aware that this does not retract any e-mail reminders for the events.</td>
</tr>
<tr>
<td>Credit Hold</td>
<td>Use when the matter is on hold due to credit checking. Credit Hold functions like Open.</td>
</tr>
<tr>
<td>Hold</td>
<td>Use when the matter is on hold for any reason. Hold functions like Open.</td>
</tr>
<tr>
<td>Inactive</td>
<td>Use when the matter has concluded, yet there are still outstanding activities such as A/R, WIP, or trust balances. Journal entries are allowed, but no events or transactions.</td>
</tr>
<tr>
<td>Open</td>
<td>Use for in-progress matters. All types of entries are allowed. Additional status types can be created for personal tracking purposes that behave like Open.</td>
</tr>
<tr>
<td>PreTrial</td>
<td>Use for those matters in the pretrial stage of litigation. PreTrial functions like Open.</td>
</tr>
<tr>
<td>Pending</td>
<td>Use for new files that have not passed through the conflicts checks and other review processes. Transactions and events can be entered, but not journal entries or statements.</td>
</tr>
<tr>
<td>Declined</td>
<td>Use when the firm has encountered a conflict on a pending matter and has declined the work. No type of entry is possible when the status has been set to Declined. Declined functions as Closed.</td>
</tr>
</tbody>
</table>
GETTING STARTED

- **Copy related contacts**: When you copy a matter to create a new matter or submatter, you need to decide whether related contacts should be copied to the new matter. Use the drop-down to choose one of the following:
  - To copy all related contacts
  - To not copy any related contacts
  - To prompt whether to copy the related contacts

- **Rate Level**: Specify the rate level used on most matters.

- **Use simplified billing tab**: If the firm does not use compensation formulas, matter budgets, or rate/component overrides, specify to use the simple billing tab by default. The Billing tab can be toggled between simple and complex on each matter.

- **Track assigned professional history**: Check this box to track when professionals have been assigned to a matter, when their assigned type or percentage changed, and when they stopped being assigned to a matter. An additional button displays in the Assigned Professionals grid on the General tab. Users are prompted for effective dates and the appropriate actions to take when changes are made. Enabling this feature can take a long time if there are many matters in ProLaw.

DOCKET

- **Next event no.**: Specify the starting point for the event number.

- **Holidays**: Enter a date and description for the holidays that you want excluded when you are using business days to calculate date relationships between parent and child events. Clicking Auto-Fill fills in the specified number of year’s worth of holidays.

  **Note**: The holidays listed here will appear on all users’ dashboards.

  **Note**: Rules sets date calculations take the holidays listed here into account.

- **Choose place from list**: Do check this box, if you want the Place field on the Events tab to tie to a list.

- **Require date on docket entries**: Forces you to enter a date for each event.

- **Require a professional on docket entries**: Forces you to select a professional for each event.

- **Save notes when changing docket type**: When this is enabled and you change the docket type on an existing docket event, the notes are preserved. Otherwise, the notes are changed to the default notes for the new docket type.

- **Confirm change in event date for parent events**: Pops up a confirmation box when parent events' dates are changed.

- **Groupware/e-mail subject line calculations**: This is the text that displays as the subject line in an e-mail, e-mail reminder or appointment sent from ProLaw. You can write your own calculation for this. It is important that you get good at writing calculations. You can test them in Matters reports to see if they work. However, ProLaw has lots of defaults, so hopefully one of these meets your needs.

  Let's assume that you're using matter 1001-001, the description is Application for Patent, the client sort is Larkspur Polymers, your initials are SLO and you're docketing a Deposition.
Default groupware/e-mail subject line calculations are defined in the following table:

<table>
<thead>
<tr>
<th>SUBJECT LINE CALCULATION</th>
<th>DESCRIPTION AND EXAMPLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>MattersQuery.ShortDesc + '(' + MattersQuery.MatterID + ' ')'</td>
<td>1st 70 characters of matter description+matter id. Example: Larkspur Polymers vs. Industrial Fastners, Inc. (1001-002)</td>
</tr>
<tr>
<td>MattersQuery.ClientSort + '(' + MattersQuery.MatterID + ' ')'</td>
<td>Client Sort+Matter ID. Example: Larkspur Polymers (1001-002)</td>
</tr>
<tr>
<td>MattersQuery.ClientSort + '/ '+ MattersQuery.ShortDesc + '(' + MattersQuery.MatterID + ' ')'</td>
<td>Client Sort/1st 70 characters of Matter Description+matter id. Example: Larkspur Polymers vs. Industrial Fastners, Inc./Larkspur Polymers (1001-002)</td>
</tr>
<tr>
<td>'EventInitials' + ': '+ MattersQuery.ClientSort + '/ '+ MattersQuery.MatterID</td>
<td>Initials of Professional assigned to event:+client sort+matter ID. Example SLO: Larkspur Polymers/1001-002</td>
</tr>
<tr>
<td>MattersQuery.MatterID + '(' + MattersQuery.ClientSort + ')':</td>
<td>Matter ID+Client Sort Example, 1001-002 (Larkspur Polymers)</td>
</tr>
<tr>
<td>MattersQuery.MatterID + '(' + MattersQuery.ShortDesc + ' ')'</td>
<td>Matter ID+1st 70 Characters of Matter Description example, 1001-001 (Larkspur Polymers vs. Industrial Fasteners)</td>
</tr>
</tbody>
</table>

- **Docket Children**: Use this drop-down to select what happens to child events when the parent is marked as completed:
  - Complete future child events when parent is completed.
  - Do not complete future child events when parent is completed.
  - Prompt to complete future child events when parent is completed.

- **Use matter's assigned professional**: Select this option to disable the Assigned tab on Docket Types. When users enter an event, the professionals that display on the General tab are automatically assigned to the event.

**Auto-fill holidays**: Select how many years in the future holidays should be auto-populated when the auto-fill button is pressed.
## DOCUMENTS

<table>
<thead>
<tr>
<th>FIELD</th>
<th>PURPOSE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next document no.</td>
<td>Input the starting number for the document numbering. ProLaw uses this number as a starting point for naming and numbering documents assembled through ProLaw as well as drag and drop documents.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If replicating, it is necessary to have each site have its own starting document number that is easily discernible (site 1 = 100000, site 2 = 200000 etc.).</td>
</tr>
<tr>
<td>Default document type for drag and drop files</td>
<td>Specify the Document Type that should be assigned automatically when a document is dragged into a ProLaw matter. A blank or empty document type is usually used. See Set up document types for more information on creating document types.</td>
</tr>
<tr>
<td>Default document type for PDF copies</td>
<td>Specify the Document Type that should be assigned automatically for an Events record created when a document is copied and saved as a PDF file.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Only document types that can be used in Matters and Contacts can be selected. Document types that are used by only matters (or only contacts) will not appear in the list.</td>
</tr>
<tr>
<td>Store documents in</td>
<td>Specify the network path where documents should be stored. Store the documents in a ProLaw subdirectory or on a separate server. It is important that all users have full access to the directory where documents are stored. This location should be set up using UNC pathing.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you are using ProLaw Document Server, the document server name, not the network path, displays in this field. The Document Server software must already be installed and running before the server can be selected.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If Store Documents In field is populated in Professionals, documents for that professional will be stored in that directory, not the directory specified here.</td>
</tr>
<tr>
<td>Subdirectory scheme</td>
<td>Maintain up to three levels of subdirectories to keep ProLaw documents organized. For example, if Area of Law, Matter ID, and Initials are subdirectories, BEM creates a document on matter 1001-001 which has an area of law of Litigation, then the document is stored in UNC\prolaw\documents\litigation\1001-001\BEM.</td>
</tr>
</tbody>
</table>
These fields are used by ProLaw's Document Server as well as when no DMS is in use.

| Shadow documents to | Specify the local directory where a copy of documents should be kept. For example, in C:\shadow. In the event that users are unable to access the network, they can work on the shadowed version of the document stored on their own drive. **If this field is left blank, documents do not shadow.** ProLaw creates this directory if it does not exist. Do NOT store documents that were not created by ProLaw in this directory if you are using the size limitation as described below. Otherwise, they might get deleted when ProLaw cleans up the directory.

**Note:** If a user edited a document from the shadow directory, they should drag and drop that document into ProLaw to have the new version of the document stored in ProLaw.

ProLaw creates documents in the Shadow directory when:
- A ProLaw document is loaded and no DMS is in use.
- A ProLaw document is loaded and the ProLaw Document Server is in use.
- A document is being e-mailed, regardless of whether it is converted to PDF and/or renamed. If no shadow directory is specified in Matters Preferences, the file will be stored in the user's temp directory as specified in My Computer, Properties, Advanced, Environment Variables.

**Note:** If you type the shadow directory name in instead of selecting it from the browser window, be sure not to leave any trailing spaces. ProLaw will not shadow to that directory, and will not attach documents to e-mails, if trailing spaces exist.

| Limit shadow directory to | Set the size of the shadow directory. ProLaw checks the size of the shadow directory upon exiting ProLaw. If the size of the directory is larger than prescribed, ProLaw deletes documents (starting with the oldest) until the size is under the limit.

| Check out documents to | Set a default directory for checked out documents. This can be changed when the user checks documents out. ProLaw creates this directory if needed. A directory path must be specified if ProLaw's Document Server is in use.

| Full text index documents | Selecting this check box tells ProLaw that it should index all the documents contained in the document storage directory scheme. ProLaw uses a third party application called DTSearch to complete this task. If ProLaw Document Server is in use, Document Server controls where the index is stored. If the Document Server is not in use, DTSearch creates a subdirectory within ProLaw called Index wherein the Full Text Index is stored.
<table>
<thead>
<tr>
<th><strong>Limit document recipients to 50</strong></th>
<th>This setting applies to the Recipients grid that appears at the bottom of the Events tab when a document event is added. It does not apply to Contacts events or the Select Recipients window that appears when you e-mail a document. Despite the name of this preference, it does not really limit how many contacts appear in the grid. Rather, it determines whether all related contacts are listed in the grid (by &quot;all related contacts&quot; we mean both those on the General tab and those on the Related Contacts tab), or just the General tab contacts. If more than 50 related contacts exist (both General tab contacts and Related Contacts tab contacts are counted), only the General tab contacts will display in the grid. If less than 50 total related contacts exist, then all related contacts are displayed. If the preference is off, all related contacts are always put into the grid.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Replicate document types</strong></td>
<td>If this box is checked, the Document Types are stored in the database as well as in the Forms directory and are shared between replicating offices. Recommended only for replicating sites. Document types that are stored in the database are susceptible to corruption, so make sure there are stored copies of current document types outside the database.</td>
</tr>
<tr>
<td><strong>Allow read-only documents to be opened</strong></td>
<td>When this is enabled, users can open documents that are checked out or in use by others. The user gets a prompt to open read-only. When this is not checked, users have to make a copy of the document in order to open.</td>
</tr>
<tr>
<td><strong>Save notes when changing document types</strong></td>
<td>When this is enabled for an existing document type, the current event notes are preserved. When it is not enabled, the current event notes are replaced with the default notes from the new document type.</td>
</tr>
<tr>
<td><strong>Additional Directories to Full Text Index</strong></td>
<td>Useful when there are multiple sites storing documents in multiple locations; you can list all the directories to be included in the full text index. Remember to use UNC pathing when entering these directories.</td>
</tr>
<tr>
<td><strong>Exclude File Types</strong></td>
<td>Select field types to exclude from full text searching. Full text indexing is more likely to fail if inappropriate file types, such as EXE or WAV are not excluded.</td>
</tr>
</tbody>
</table>
REQUIRED FIELDS

Mark the fields that must be filled in when you open a new matter. Make sure your custom tabs are limited by the correct area of law. When the custom tabs are limited, any required fields on the custom tabs are only required for matters with the correct area of law. Required fields are covered in more detail later in Required Fields later in this topic.

HOTDOCS

You only see this tab if HotDocs is installed.

Shows HotDocs confirmation box: When this is enabled, a pop-up box displays that you can click OK. This lets ProLaw know that HotDocs is all done assembling some form.

ELITE

You only see this tab if there is an Elite.ini in your ProLaw application directory.

- **Integrate with Elite Back Office**: When this is enabled, the Matters Inquiry tab in ProLaw is updated on-the-fly based on data from the Elite database. The data is pulled using select statements that are in the Elite.ini in the ProLaw application directory. You will need the assistance of your ProLaw support representative to get this set up.

OUTLOOK

Set your Outlook integration preferences on this tab. Discussed in E-mail Integration.

SETTLEMENT

Settings and defaults for the settlement tab and the settlement worksheet. Defaults can be overridden on individual settlements; other settings cannot be altered on an case-by-case basis.

- **Default accounts/Co-counsel, lienholder, client, trust, cash**: Specify the default checking accounts when cutting checks to co-counsel, clients and lienholders; the account in which to deposit firm fees earned, and the default trust account in which to deposit settlements.

- **Default statement format**: The settlement statement format most commonly used.

- **Calculate co-counsel fees as a percentage of firm fees**: Co-counsel gets a percentage of the firm’s percentage. Otherwise, co-counsel receives a percentage of the whole settlement.

- **Place co-counsel checks on hold**: System-generated checks to co-counsel are automatically placed on hold.

- **Use tiered percentages when calculating firm fees**: If the firm receives, for example, 1/3 of the settlement if the settlement is less than $100,000 and 1/4 of the settlement if the settlement is over $100,000 but less than $200,000, tiered percentages are used. Co-counsel can also be setup to use tiered percentages. Tiered percentages are covered in Settlement.

- **Use tiered percentages when calculating referral fees**: Co-counsel fees use tiered percentages.

- **Include items on hold in settlement**: Transactions that are on hold are calculated into the firm’s check. Otherwise transactions on hold are excluded.
**Deduct costs before fees:** Fees can be deducted either before or after costs. Set the default for the most commonly used method.

**Include batch transactions:** If not checked, only WIP transactions are deducted from the client's net.

**Enter deposit:** Create a trust deposit for the settlement amount automatically.

**Enter payment:** Create the cash receipt for the firm's portion of the settlement automatically.

**Include hard costs:** Deduct hard costs from the net to client.

**Include soft costs:** Deduct soft costs from the net to client.

**Include fees:** Cannot be used if tiered percentages are used. ProLaw writes up/down existing fee transactions to match the firm's percentage.

**Include co-counsel:** By default the co-counsel check box is checked on the settlement worksheet.

**Include liens:** By default the liens check box is checked on the settlement worksheet.

**DMS**

If the firm wants to integrate ProLaw with an outside document management system(s), set up the integration from this tab. DMS integration is covered in Document Management Integration.

**EVENTS PREFERENCES**

There are no system-wide preferences in Events Preferences.

**FILES PREFERENCES**

To auto-track time when opening a Files record, select the appropriate option in Transactions Preferences.
FILE ID TAB

File ID Type

- **Prefix file ID with Matter ID**: Uses the Matter ID in the file ID. For example, when opening a file for matter 1001-001, the file ID is 1001-001.001.
- **Prefix file ID with numeric increment**: Uses an incrementing number in the file ID. For example, your next file number could be 500.001.
- **User defined file ID**: Use this if you want to type the file IDs in yourself.

**Next prefix**: If you are using an incrementing number in your file IDs, select beginning number for the next file you open through ProLaw. For example, if you enter 500 in this field, your next file id is 500.001.

**Zero pad to x digits**: If you are using an incrementing number in your file ID and you want to pad it using zeroes so that is a certain number of digits, select the total number of digits you want the prefix to be. For example, if you have 500 set as the next prefix and you select 4 in this field, your next file ID is 0500.001.

**Subfile delimiter**: The ".001 that displays in the examples above is an example of a subfile number. If a delimiter other than a period should be used, enter that character in this field.

**Make the top most file prefix only**: Check this box, if you want the main file to simply be the matter ID or the numeric increment. You can then create subfiles under that main file that uses the subfile delimiter and an incrementing number. For example, if you are assigning your file IDs based on Matter IDs, the top most file for matter 1001-001 is numbered 1001-001, and then the next subfile created for that matter is numbered 1001-001.001. If you are assigning file IDs based on a numeric increment, your main file is numbered 500 and the first subfile is numbered 500.001.

DEFAULTS

Defines defaults that can be pre-filled each time a file is created:

- File Class
- File Type
- Location
- Status

You can specify that the current user's initials be used as a default for the following fields:

- Opened Initials
- Location Initials
- Status Initials

It is possible to specify some default behavior for the create from and create subfile procedures:

- Use defaults when performing create from or create subfile
- Copy related file records when performing create from
- Create relationship between files when performing create subfile

Column name for Miscellany field: Allows the user to change the name of the Miscellany field.
HISTORY

- **Track file location history**: Check this box if you want to track file location history.
- **Changes that create a new record**: It may not be necessary to track every change to the file location to create a new record for the file location history, therefore check the boxes for the fields where changes should create a new record in the file history.
  - Location
  - Location Date
  - Location Initials
  - Specific Location
- **Suppress time in location date**: Check this box if you do not need a time stamp on the date for a change in the file location.
- **Track file status history**: Check this box if you want to track the file status history.
- **Changes that create a new record**: It may not be necessary to track every change to the file's status to create a new record in the status history, therefore check the boxes for the fields where changes should create a new record in the status history.
  - Status Date
  - Status Initials
  - Reason
  - Status
- **Suppress time in status date**: Check this box if you do not need a time stamp on the date for a change in the file status.

REQUIRED FIELDS

Mark the check boxes for the fields that you want users to be forced to enter whenever they open a new file:

- File Name
- File Class
- File Type
- Opened Initials
- Reworked initials
- Review Initials
- Location initials
- Specific Location
- Status Initials
- Status Reason
IMPORT

These settings are used to import location information from a file produced by a hand-held scanner. The import does not create records for new files; it creates location information for existing files:

- **Default Import File**: The location and filename of the file produced by the hand-held scanner. If you use the browse button to browse to the file and select it, both fields (for the directory and the file name) are entered. You can select to have the file deleted or renamed after the import. If you rename the file, the extension is changed to ~1. The most recent import file is always the one renamed ~1. Earlier existing files have the number following the "~" incremented (i.e., ~2, ~3 and so on).

- **Log File**: Is automatically entered after you select the name of the file to be used for import. The log file tracks the current settings for the import (the import file name and log file and reject file names) along with the start and end time for the import. The log file name is the name of the import file with an LOG extension. Enabling the suppress overwrite option means that the log is appended to each time you import rather than overwritten.

- **Reject File**: Is automatically entered after you select the name of the file to be used for import. The reject file contains the detail of the records that could not be imported for one reason or another. The most common reasons are: missing or invalid professional, missing or invalid file ID, missing location or an invalid date. The reject file has the same name as the import file with the extension REJ. Enabling the suppress overwrite option means that the reject file is appended to rather than overwritten the next time you import.

For information on importing file locations, see Files.

TRANSACTIONS PREFERENCES

Transactions Preferences have many, many options.

DEFAULTS

**Component**: Enter the most-commonly-used component here. It can be either a fee component or a cost. The default component for new transactions is determined in the following fashion: Use the user-level default component specified on the Options tab in Transactions Preferences. If no user-level default exists for the current user, use the system-level default component specified here. If there is no system-level default either, the component on new transactions defaults to the component on the transaction that is selected when the user presses the **Add** button. If no transaction is selected, the default component will be T. If no component with the id T exists, then there will not be a default when new transactions are created.

*Note: Users can change the component during data entry or edits.*
ABBREVIATIONS

Abbreviations are an easy way to streamline creating the narrative for time entries. To add abbreviations to the Abbreviations list:

- Click the Add button on the right side of the Abbreviations list.
- Enter the abbreviation into the Abbreviation field and the text you want to display when the abbreviation is used into the Description field.
  - Do not use initial capital letters in the description, because ProLaw automatically provides initials caps if an abbreviation displays at the beginning of the narrative or after a period in the narrative.
  - ProLaw does not recommend using numbers as abbreviations, because abbreviations are also active in all notes fields. Since they are active in notes fields they are also useful as shortcuts to producing common city, state combinations when entering contact addresses or default text when entering event notes.
- Print the Abbreviations list by clicking the Print button on the right of the Abbreviations list and selecting Listing.
- Click Print again to send the Abbreviations Listing to the printer.

Abbreviations entered on this tab are available to all users. Users can create their own abbreviations on the User Abbreviations tab, and it is also possible to create matter-level abbreviations.

SETTINGS

- **Lock Transactions through:** In order to prevent users from entering transactions in the past, set this to the day before earliest date that they are allowed to create transactions.
- **Lock transactions after:** In order to prevent users from entering transactions in the future, set this to the last date that they are allowed to create transactions.
- **Require narrative:** Requires user to enter narrative for each transaction. When selected, this option allows the user to tab to the narrative field from the transaction information above. Does not work well when combined with the Default Narrative to Matter Description option because there is automatically a narrative.
- **Default narrative to matter description:** Automatically places matter description in the narrative field.
- **Capitalize the first character of narrative:** Automatically capitalizes the first character of the narrative you type in.
- **Use units in square brackets from narrative when present:** If the user enters numbers enclosed in square brackets in their narrative, the units for the transaction are automatically adjusted based on the entries in the square brackets. For example, if the narrative contains “Telephone conference with client [.3]; telephone conference with opposing counsel [.5] the units for the transaction are automatically changed to .8. ProLaw has also provided some shortcut keys to help you use this feature effectively:
  - Shift+Alt+Insert: Inserts [0.00] into the narrative at the point of the cursor.
  - Shift+Alt+F12: Takes you to the next instance of bracketed units.

*Note: For the following keystrokes to work as described, everything within the brackets must be highlighted.*
  - Shift+Alt+Up Arrow: Increases the tenths of the units by one each time you press the up arrow.
  - Shift+Alt+Down Arrow: Decreases the tenths of the units by one each time you press the down arrow.
GETTING STARTED

PREFERENCES

- Shift+Alt+Right Arrow: Increases the hundredths of the units by one each time you press the right arrow.
- Shift+Alt+Left Arrow: Decreases the hundredths of the units by one each time you press the left arrow.
- Shift+Alt+Page Up: Increases the whole units of the units by one each time you press page up.
- Shift+Alt+Page Down: Decreases the whole units of the units by one each time you press page down.

The units field in transactions is updated based on the bracketed units when you post the transaction by clicking Save or beginning a new transaction.

- **Time entry by week**: When the user is on the Time Entry tab, all entries for the week are displayed (the Sunday through Saturday span that includes the date that displays in the Date field).
- **Include costs on the Time Entry tab**: When this is not checked, users can still create cost transactions while on the Time Entry tab. However, those transactions are excluded from their search results. Therefore, if the user exits ProLaw and returns later (or clicks Move to WIP which also refreshes the query), the cost transactions do not display and the user may become alarmed.
- **Allow non-zero transactions to be hidden**: Allows you to hide transactions that do not have a zero extended amount. The amount of the transaction is included in the bill so you need to be careful what statement formats you use this feature with. For example, you may want to use this when you do not want some narrative to be included on a summary bill. However, you probably should not hide non-zero transactions if you are using a detailed statement format that includes the amount for each transaction.
- **Default matter from previous transaction**: When you add a new transaction, the matter ID defaults to the matter for the previous transaction.
- **Use statement professional's rate for fees**: The statement professional is the one who displays on the bill, which can be different than the one on the transaction itself. If you check this box, the rate is changed to reflect the rate level assigned to the statement professional and the value is recalculated accordingly.
- **Use fee component description as narrative**: Inserts the description of the fee component into the narrative.
- **Hard cost transactions can only be entered from Journals**: When enabled, prevents the user from entering a hard cost directly into Transactions.
- **Require time entry in increments of X minutes**: If the firm requires that time be entered in, for example, ¼-hour increments, enter 15 here. Professionals are required to enter .25, .5, etc. in the units field when entering time. Note that this field does not affect the allowable units when entering costs.
- **Allow timer**: If unchecked, users are not able to use the timer in the Time Entry view nor the Today's Time window. See Transactions for a description of the Timer.
- **Round timer up in increments of X minutes**: The smallest increment for which the firm bills (for example, in 15 minute increments).
- **Use Client Agency**: Enables Client Agency by making the Client Agency fields visible in Contacts, Matters, and Transactions. See Client Agency for more information.
- **Allow negative units**: Allows users to enter transactions with negative units. If this feature is not selected, users can still enter negative transactions, but they must enter a negative price instead of negative units. If the feature is enabled, users can enter transactions with either negative price or negative units. This setting is dependent on Client Agency and is invisible if Client Agency is not selected. See Negative Units Administration for more information.

58
STATEMENTS

Preferences on this tab are covered in Statements.

TIME ENTRY WINDOW

The settings on this tab are the system-level equivalents of the options by the same name found on the Options tab in Transactions Preferences. On that tab, users can select to automatically open the Time Entry window when performing the below actions. You can override their selections using the settings on this tab. If you set any of the options here, the Time Entry window will open when all users who have security to change Batch perform the selected action (under timekeeper licensing, the professional must also be an active timekeeper in order for the Time Entry window to automatically open; under seat licensing, the Time Entry window will auto-open for any active professional with the appropriate security). The users’ corresponding settings on the Options tab will be disabled and selected. The fact that this tab overrides the user-level settings is very rare; usually in ProLaw the user-level or more granular settings override the system-level settings.

For more information on auto-tracking time, see Auto-track Time in Transactions.

- **Auto-track time when viewing a matter**: The Time Entry window will open when users open a matter's record view.
- **While viewing a file**: The Time Entry window will open when they open a file's record view.
- **Pro Filing settings**: If Pro Filing is enabled in System Preferences, you can also elect to auto-track time when opening a file in a Pro Filed application. The Time Entry window will open any time a file in that application is opened, whether it is opened the file from the Events tab, EOTD, the Create Document window, or directly in the application. These options are disabled if Pro Filing for the application is off.
  - **Opening a document in Word**: The Time Entry window will open any time a Word document is opened.
  - **Opening an e-mail in Outlook**: The Time Entry window will open any time an e-mail is opened.
  - **Opening a document in Adobe**: Same as above, but for Acrobat and Reader.
  - **Opening a spreadsheet in Excel**: Same as above, but for Excel.

JOURNALS PREFERENCES

Journals preferences are covered in the Journals Setup topic.

LEDGER PREFERENCES

STATEMENT IMAGES TAB

**Images directory**: Where to save the images. Images are stored to disk in PDF format.
Extract statement images to PDF:

These settings are for firms who previously saved statement images to the ProLaw database and now want to extract them to PDF. ProLaw no longer offers the option to store new images in the database, but old images remain there unless they are extracted using this tab.

- **Delete statement images from database as extracted:** This extracts the statement image to the specified directory, and deletes the data for the statement image from your database. This may also reduce the size of your database.
- **Extract and remove orphaned statement images:** This removes images which are not associated with records in Ledger. This setting is useful for archiving suspect data and light database maintenance.
- **Only extract if statement date on or after:** This allows you to limit the extraction of statement images with a beginning date. Enter the date in the text box.
- **Only extract if statement date on or before:** This allows you to limit the extraction if statement images with an ending date. Enter the date in the text box.
- **Only extract statement number:** This allows you to limit the extraction of statement images to a single statement. Enter the statement number in the text box.

If you check none of the extraction preferences and choose the Extract button, all of the statement images in your database are extracted to the images directory specified.

**Note:** Extracting the statement images from the database requires exclusive database access and is server intensive. It is recommended to run extracts during non-business hours.

REQUIRED FIELDS

When someone adds a contact or matter, it is likely that there are pieces of information that you want the users to be forced to enter before they can save the record.

CONTACTS

1. In Contacts, select Preferences from the Tools menu.
2. Click on the Required Fields tab.
3. The grid includes some default ProLaw fields from the General tab (Class, Salutation and Title) as well as the fields from custom tabs. Mark the Required check box for each field that is required for a contact.
   
   **Note:** Custom tabs should be limited by contact class so that they only displays for contacts with a given class. This also means that required fields on class-limited tabs are only enforced for contacts with the selected class.

4. Click OK to close Preferences.

When a user adds a contact and tries to save the contact without having entered information into the required fields, ProLaw informs the user that the field must be populated. The user is not able to leave the contact until the field is populated.

What happens if a user edits a contact that was added before required fields were enabled and that contact does not have the required fields populated? When the user tries to save the edits, ProLaw informs the user that the field must be populated. The user is not able to leave the contact until the field is populated.
What happens if the required field is on a custom tab that is not limited by contact class? You are required to fill in that field for all contacts whether they have been assigned a contact class or not.

Caution: Exercise restraint when marking fields as required. You do not want to put your users in a position where they are entering bogus data (e.g., N/A) because a field is required but they do not have the necessary information to fill in the field properly.

### MATTERS

1. In Matters, select Preferences from the Tools menu.
2. Click on the Required Fields tab.
3. The grid includes some default ProLaw fields from the General tab (Area of Law, Matter Type, Opened Date, Status and Status Date) as well as the fields from your custom tabs. Mark the Required check box for each field that is required for a new matter.

   **Note:** Your custom tabs should be limited by areas of law so that they only display for matters with a given area of law. This also means that required fields on area of law-limited tabs are only enforced for matters with the selected area of law.

4. Click OK to close Preferences.

When a user adds a matter and tries to save the matter without having information into the required fields, ProLaw informs the user that the field must be populated. The user is not able to leave the matter until the field is populated.

What happens if a user edits a matter that was added before required fields were enabled and that matter does not have the required fields populated? When the user tries to save the edits, ProLaw informs the user that the field must be populated. The user is not able to leave the matter until the field is populated.
What happens if the required field is on a custom tab that is not limited by area of law? You are required to enter information into that field for all matters whether they have been assigned an area of law or not.

**Caution:** Exercise restraint when marking fields as required. You do not want to put your users in a position where they are entering bogus data (e.g., N/A) because a field is required but they do not have the necessary information to fill in the field properly.

**PROLAW TOOLBAR**

When ProLaw initially opens, a window appears that allows you to open the various areas of ProLaw (Matters, Contacts, Transactions, etc.) You can choose whether this initial window should be the Toolbar or Dashboard.

Most people use the ProLaw Dashboard, but some prefer the traditional Toolbar. The Dashboard displays your calendar entries for the day and allows you to add events and time entries without opening the corresponding matter, contact, or the Transactions window. It also has regular **File**, **View**, etc. menus. The Toolbar, on the other hand, is a tiny window that just shows buttons for the main areas of ProLaw. There is no calendar and no way to create events or transactions directly from the Toolbar. It has a right-click menu that serves many of the same purposes as the Dashboard's **Tools** menu. You can toggle between the Dashboard and Toolbar.

The Toolbar looks like the image below. It is less than 5 inches long, so the below image approximates the Toolbar's actual size:

![Toolbar Image](image)

The buttons on the Toolbar are the same as the buttons on the top of the Dashboard's Shortcuts pane, so see that section for an explanation.

**TOGGING BETWEEN DASHBOARD AND TOOLBAR VIEW**

If you are using the Dashboard and want to change to the Toolbar, select **Toolbar** from the **View** menu.

If you are using the Toolbar and want to change to Dashboard view, right-click on the Toolbar and select **Dashboard**.

**RIGHT-CLICK MENU**

*Query Definitions, Setup, Matter Conflict Votes, OnePass Settings, Open Recent window, and Open Today's Time window* are all discussed in Dashboard Tools Menu in Setup.

**Toolbar Preferences:** Opens Toolbar Preferences which are just like Dashboard Preferences except there is no Calendar Settings tab.
Always on Top: Check if the Toolbar should always be visible even if another window occupies the same space.

Dashboard: Toggles to the Dashboard view.

Help: Opens Help.


SEARCH VIEW

Most ProLaw windows open to a Search form. The form contains your search criteria at the top, and a grid with the search results at the bottom. The rows in the grid display in alternating colors for a "green bar" effect, making it easier to find your place in large results sets.

Search forms usually have several views. Quick Find is available on all search forms. Most also have a Query view where you can enter a natural language query. Many windows also have individualized Search forms, for example, Contacts contains a Conflicts view, Contacts and Matters contain a Recent view. Events off the Dashboard has two views for managing documents, picklists often have a View All view, Transactions has a Time Entry view, and so on. In many forms that have the Query view, you can also build customized queries, save them, and have them appear as views.

Search windows have a Shortcuts pane on the far left, the window's toolbar along the top, the search criteria in the middle, and the search results grid on the lower right.

If you have the Matters preference to auto-search after pause in Find on, the search will execute as soon as you stop (or pause) typing. If that preference is off, click the Start find button next to Search by to see your search results.
The Shortcuts pane usually contains **View**, **Actions**, and **Tools** sections. The items in these sections can also be accessed from the **View**, **Tools** and **Actions** menus. **Tools** and **Actions** typically contain tasks you can perform in the current window. When you select an item from **View**, the search criteria area of right-hand side of the screen changes to show that view. The search results grid works the same in all search views, although sometimes the default visible columns change depending on which view you select.

The search results grid contains pre-defined columns. For Contacts, Matters and Professionals, it also contains custom fields that appear on the first custom tab. You can customize the grid, for example you can select to hide some of the available columns, move, sort, re-size and group by columns, and hide the grid lines. When you open a window for the very first time, the grid may appear in an "unsorted" stated. Click on a column heading to sort the grid (see Customizing the Search Results Grid for more information on sorting).

You can add, edit and delete records directly in the search grid, provided you have security to edit this kind of record (or in some cases, a specific record or even field). Some fields must be edited in the Record View (for those window that have Record Views) and appear disabled in the Search View.
 WINDOWS-SPECIFIC SEARCH VIEWS

The **Quick Find** and **Query** views are available in most search windows. Most search windows also have views specific to that window and/or more complex **Quick Find** views than the basic **Quick Find** view.

For example:

- **Contacts** and **Matters** both display **Recent** views. To set how many records display in this area, see Preferences. Records cannot be deleted from the Recent view.
- **My Contacts** displays contacts to which the user is listed in the **Personal Contact For** grid on the **Notes** tab.
- **My Matters** displays matters for which users are assigned Professional status on the **General** tab.
- **Contacts** displays a **Conflicts** view (see Conflicts Searching for more information).
- **Events** off the Dashboard displays a complex **Quick Find** view, **Documents** and **Worklist**.
- **Transactions** displays **Quick Find**, **Query** and **Time Entry**.
- Many picklists have a **View All** view.

CUSTOM SEARCH VIEWS

User-defined views are set up in Save Query (Query Library). The query can be selected as a view under **Shortcuts** on the left side of the **Search** window. See Querying for more information on setting up custom views.

QUICK FIND VIEW

Select a ProLaw area (e.g., Matters, Contacts, etc.) to open that area's **Search** window. The search window typically has two or more tabs, or views. This section contains information about the Quick Find view. Refer to Querying for further details on using the Query view, and each area's topic for information on window-specific search views.

The **Quick Find** view contains search fields for performing a simple search. In some windows such as Journals, Transactions and Events off the Dashboard, the Quick Find view has multiple search criteria. In other windows such as picklists, Contacts, and Matters, you can only search by one field.

Select the field to search for and by. For example, if you know the matter ID, enter it in the **Search for** field and select **Matter ID** from the **Search by** drop-down list. In Contacts, if you know the company name, enter it in the **Search for** field and select **Company** from the **Search by** drop-down list. The available **Search by** fields change depending on which window you are in.
After the search is executed, any records matching your search criteria display in the grid.

As you type in the **Search for** field, ProLaw suggests the rest of the search text by auto-filling the last thing you searched for that begins with the characters you are typing. You can press **Backspace** or **Delete** to remove the suggested search text.

ProLaw remembers the last ten searches you entered for each possible **Search by** option. Press the arrow on the right of the **Search by** field to select a previously-run search. What appears in the dropdown changes depending on which field you are searching by (and which window you are in, of course).

If you do not enter anything to search for, the search will return all records. Use blank searches with caution, since they can take a long time to process.

**CUSTOMIZING THE SEARCH RESULTS GRID**

You can alter the columns in ProLaw's search grids to show the information that is important to you in the order in which you like to see it. Some windows, such as Transactions, store different grid settings for different views. Journals shows different columns depending on the type of journal entry you have selected to view. Other windows, such as Matters, have only one set of grid settings per user.

For all the main ProLaw windows and many subsidiary windows such as picklists, ProLaw remembers your grid settings between sessions. Customizations to the search results grid are saved to the database on a per-user basis, not per-workstation basis, so that you have the same settings if you switch computers.
COLUMN ORDER, DATA SORTING AND WIDTH

You can alter the grid’s column order, data sorting and width.

- The columns can be reordered by dragging the column heading to a different location.
- Clicking a column header sorts the data by that column. Clicking the heading again reverses the sort order. Clicking the column a third time returns the column to the “unsorted” state.
- The columns can be resized by dragging the column edges to make the column wider or narrower.

GRID LINES

You can turn the grid lines on and off by right-clicking in the grid and selecting **Customize grid**.

For more information on customizing the search grid, see Selecting Visible Columns, Grouping Search Grids, and Filtering Search Grids.

FILTERING SEARCH GRIDS

After you have searched for some records in the Search View, the search results can be narrowed down further by filtering them. Click the drop-down arrow on the right side of the column header.

What appears in the filter dropdown is limited to the search results. For example if you search in Matters for matter ID's beginning with "10," the **Matter ID** filter dropdown will contain only those matter ID's, not every matter ID in the database.
You can select multiple values from the dropdown by simply clicking on additional values in the list until all the desired values are selected. You can also filter on additional columns.

Click the filter dropdown for the column that will have the broadest (highest) level of filtering and select the desired value(s). Click elsewhere in the grid to close the filter dropdown. The list will filter. Then select the column that will have the next level of filtering, and pick the desired values.

Once the filter has been applied, the search results change to show only the qualifying record(s). The icon for the filter dropdown changes so you know there is a filter applied:

Clear the filter by clicking the filter dropdown on that field again and selecting Clear Filter at the top:
SELECTING VISIBLE COLUMNS IN SEARCH GRIDS

You can select which columns to view in each of ProLaw's search grids from a pre-defined list. To select visible columns, click on the box in the extreme top left corner of the grid:

The list of columns available for that window appears. For example, here is a list of available columns for Matters.

Custom fields on the first custom tab will appear in this list for Contacts, Matters, and Professionals. The columns appear in the order in which they appear in the grid, not in alphabetical order. Uncheck the box next to the column name for any columns that you wish to hide. You can turn the hidden columns on again later if desired.
GROUPING SEARCH GRIDS

Most search grids (Journals is a notable exception) can be grouped by a certain column by dragging the column heading to the grouping box between the search criteria and the grid. If the grouping box does not appear in a grid that should have it, right-click in the grid and selecting Customize grid. Check the Show column grouping box option.

That column appears in the grouping area (and also remains in the search grid).

The grid groups are automatically collapsed. Each group heading lists how many records are in that group. Click the plus or minus signs to the left of the group heading to expand/collapse. You can also right-click on a record in the grid and select Expand or Collapse Grid to expand/collapse all the groups at once.

If you print the search grid at this point, it would print exactly as it displays.
SHORTCUTS PANE MENU BAR

The **Shortcuts** pane’s menu bar appears in the left hand pane of the search form. The Shortcuts pane does not display in record form windows, only search windows. It provides links to the most commonly-used features in the current window. It can also contain shortcuts to custom queries commonly used at your firm. Which options appear

Here is the Matters Shortcuts pane:

- **View section**
  - Quick Find, Recent and Query: These views are analogous to the Find, Recent and Query tabs in previous versions of ProLaw.
  - View All: This option is only available only in certain windows. It may be necessary to run a blank query to see all records if View All is not available (it might take a long time to get the search results).
  - My Contacts and My Matters: These views display contacts or matters to which the user is assigned. In **Contacts**, contacts display that list you in Personal Contact For on the Notes tab. In **Matters**, matters for which you are an assigned professional on the General tab display.
**GETTING STARTED**

- **Custom views:** Commonly-used queries can be saved in **Save Query**, and marked to appear on the **View** menu. The saved queries' names then appear as custom views. When a custom view is selected, the query's results will automatically appear in the search grid.

  See Search View for information about navigating these views.

- **Actions:** Displays some of the options from the **Actions** menu. For the base search window, the displayed options are **Print grid** and **Save grid**.

- **Tools:** Displays some of the options from the **Tools** menu. For the base search window, the displayed options are **Query builder**, **Save query**; and **Preferences**.

  **Note:** Collapse the Shortcuts menu bar by clicking the splitter bar. You can resize the Shortcuts menu bar by dragging the splitter bar to the left or right.

**RECORD VIEW**

Contacts, Matters, Professionals, and other windows that contain more information than can display easily in a grid have a Record View in addition to the Search View. All of a record's details are visible on the Record view, while only a subset of that information is available in the Search View. For windows that do not have a Record View (such as simple picklists), all the information for the record is visible in the search grid.

You can add, edit, and delete records in the Record View similar to how you manage them on the Search View. You can only edit records, fields and tabs to which you have appropriate security.

There are four ways to open the Record View window after selecting the desired row in the search results grid:

- From the **File** menu, select **Open Item**
- Press **Ctrl+O**
- Double-click the desired row
- Select the **Open** button on the top left

  The record view will open to either the first tab (usually the General tab), or the tab that was visible the last time you opened a record of this type. Whether or not the first tab is initially selected when a record view's window opens is controlled by a user-level preference.

**VIEWING MULTIPLE RECORDS USING THE RECORD VIEW**

You do not have to close a record's Record View if you want to look at the Record View for another row in your search results. Use the navigation buttons **First, Next, Last,** and **Prior** to navigate through your search results without leaving the Record View. If you use these buttons, the next record you view will display in the same window as the first record.
If you want to open the Record View for multiple records, for example you want to see the details for two matters simultaneously, leave the Record View for the first record open, select the Search View and double-click or otherwise open the next desired record. This way, two Record View windows will be opened, one for each matter.

RECORD VIEW WINDOWS

Record View windows have menus, toolbars, a record header, and tabs.

RECORD HEADER

Below the toolbar and above the tabs, the top portion of the window contains fields that identify the record. For example, the Matters header contains the Matter ID, Description, and client name:

![Record View Window](image)

The Contacts header contains the contact name, and class, the Professionals record header contains name and initials, and so on.

TABS

Record View windows contain tabs for all the various information on the record. Different tabs appear depending on whether you are in Files, Matters, etc. The system administrator can also create custom tabs for Contacts, Matters, and Professionals. Within a given window, different tabs can appear depending on what type of record is selected. For example, ProLaw can be set up to display a Trademark custom tab for matters with Area of Law Intellectual Property, and to display a Victims tab for matters with AOL "Criminal."

MENUS

Menus are discussed separately. For window-specific menu items (for example, menu items that appear only in Matters), see the topic on that particular area of ProLaw.
TOOLBARS

Toolbars are also discussed separately.

TOOLBARS

Here is a sample ProLaw toolbar:

![ProLaw toolbar]

Toolbar appearances can be customized. See Customizing Toolbars for more information.

ADD, DELETE, COPY AND OPEN BUTTONS

![Add, Delete, Copy, Open buttons]

Click these buttons to add, delete, copy or open a record. Most of these buttons display on toolbars in the record and search windows, as well as on the File menu.

**Add**

Click this button to add an item.

- If in a search window displaying a record window, a new record window displays with blank fields.
- If already in a record window, a new window displays for data entry (if new records are added, each displays its own window).
- If you are in the process of editing a record, changes are posted before the new record is created. If ProLaw is unable to post any changes, a message displays in the status bar and a new record is not created.

**Delete**

Click this button to delete the selected record, whether it is in a row on a search grid or in a record form. If the user is in a record form, it closes when the item is deleted. ProLaw confirms that the item to be deleted is not in use on another record. If it is in use, it will not be deleted and a message displays in the status bar.

**Copy**

Click this button to copy an item. This button is only available in some windows. When an item is copied, it is replaced in the current record form with a copy of the item. If in a search window displaying a record window, the copy displays in a record window. If the user is in the process of editing a record, changes are posted before the copy is created. If ProLaw was unable to post changes, a message displays in the status bar and a copy is not created.

**Open**

This button only appears search views for windows that have a record form, such as Contacts and Matters. Open the selected row’s record view.
EDIT BUTTONS

Click these buttons to cut, copy and paste items in the current field, or to undo the last action. Note that undo does not restore deleted records; it just un-does the last edit made to a field.

HOT KEY BUTTONS

Hot key buttons allow users to quickly navigate to records in another module. For example, a user can click the Matters to Ledger hot key button to open Ledger and search for that matter’s ledger records. Which hotkeys appear change depending on which window you are in.

DATABASE BUTTONS

The Database buttons are primarily used for navigating current data sets. The arrow buttons navigate to the first, previous, next and last records. You can also refresh the results set. The Save button is used to be doubly-sure that the edits you just made posted to the database, but it should be noted that ProLaw auto-saves edits when you exit the field.

PRINT BUTTONS

- **(Print Reports)** Click this button to print reports for the records that currently display in the list grid. See Print Reports.
- **(Print Grid)** Click this button to print the data that is currently displayed in the list grid. Available on the search form only.
- **(Save Grid)** Click this button to save the data that is currently displayed in the list grid. File formats include html, xml, xls and txt. Available on the search form only.

HELP BUTTON

Click this button to display the Help file.
DESIGN BUTTON

Click this button to design record forms by adding fields to custom tabs in Contacts, Matters, and Professionals. This is available only for authorized users and correct procedures must be used when making database changes. See Custom Tabs and Fields for more information.

CUSTOMIZING TOOLBARS

There are some options that affect how toolbars display throughout ProLaw. These options affect all toolbars, but can be customized for each user. Users can also customize the size of the buttons and whether captions are used. Select Customize from the toolbar customization menu to display the Customize Toolbars window, in which these selections can be made.

These settings affect all toolbars in the application, but are user specific. The settings are saved in the database for each user.

- **Large Icons**: Select this check box to display large icons in the toolbar.
- **Show Captions**: Select this check box to display captions on toolbar buttons. If small icons are used, captions display to the right of the icon. If large icons are used, captions display below the icon.
- **Show tooltips**: Select this check box to display a hint when the cursor hovers over a button.
- **Menu Animations**: From the drop-down list, select how menus are to display. The options are Drop down; Slide; Unfold; or Random.
You can specify the toolbars to display for each window by right-clicking a toolbar or anywhere in the toolbar area, which displays a menu for customizing toolbars. Select or clear the check boxes for the toolbars you want to display.

PROLAW TERMS

In many areas, ProLaw has its own specialized vocabulary. Here is a list of terms that have specific ProLaw-related meanings:

<table>
<thead>
<tr>
<th>TERM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjustment</td>
<td>A journal entry that has no payee or billing party attached to it.</td>
</tr>
<tr>
<td>Assigned Type</td>
<td>The relationship of the professional to the matter. For example, originating, responsible or billing.</td>
</tr>
<tr>
<td>Billing Party</td>
<td>The contact that accepts the matter's bills.</td>
</tr>
<tr>
<td>Class</td>
<td>Each contact is assigned a class that indicates the contact's relationship with the firm.</td>
</tr>
<tr>
<td>Check</td>
<td>Credit entry in cash account to a vendor. A payable that has been paid.</td>
</tr>
<tr>
<td>Child Events</td>
<td>In previous versions of Westlaw Legal Calendaring, these were known as related events. A child event is a docket event whose date is dependent on the date of another event (which is called the parent event). A child event can also be an event that's related to another event, such as a document that is required or notes about a meeting.</td>
</tr>
<tr>
<td>Client Contacts</td>
<td>Contacts entered on a matter's General tab. ProLaw allows users to enter additional contacts as client contacts. For example, users may want to include billing parties or other counsel for the client.</td>
</tr>
<tr>
<td>Component</td>
<td>A component is used to determine the type of transaction. Components can be fees, soft costs, hard costs, interest or tax.</td>
</tr>
<tr>
<td>Contacts</td>
<td>ProLaw tracks every person or company that the firm has contact with in a firm-wide electronic address book called Contacts. Contacts is a single repository for client information, opposing parties, attorneys, witnesses and anyone else the firm needs to correspond with, for track for conflict purposes or needs for future contact. Contacts can also be used to track personal contacts, marketing information or any other persons, entities or parties as required by the firm.</td>
</tr>
<tr>
<td>Credit</td>
<td>A negative posting to a general ledger account in Journals.</td>
</tr>
<tr>
<td>Dashboard</td>
<td>The ProLaw dashboard from which users access Contacts, Matters, Events and so on.</td>
</tr>
<tr>
<td>Debit</td>
<td>A positive posting to a general ledger account in Journals.</td>
</tr>
<tr>
<td>Deposit</td>
<td>Cash receipt entered in Journals and applied to a statement.</td>
</tr>
<tr>
<td>Draft Statement</td>
<td>A draft version of the final statement. Draft statements do not have statement numbers.</td>
</tr>
<tr>
<td>Events</td>
<td>An event can be a docket event (or deadline), a document or a note (perhaps about the contents of a meeting or telephone call).</td>
</tr>
<tr>
<td>Hard Cost</td>
<td>A cost transaction for which there is an invoice, and needs to be passed along to the client. Hard costs are almost always generated by entering checks in Journals.</td>
</tr>
<tr>
<td><strong>Hot Keys</strong></td>
<td>Buttons (generally on a given window's toolbar) used to access another area of ProLaw that has related information. Also used as a verb: &quot;Hotkey to the selected matter.&quot;</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Journal Entry</strong></td>
<td>An entry in Journals. (ProLaw's General Ledger.)</td>
</tr>
<tr>
<td><strong>Journal Type</strong></td>
<td>Distinguishes between checks, deposits and adjustments.</td>
</tr>
<tr>
<td><strong>Ledger Record</strong></td>
<td>Statement, cash receipt, unapplied cash or write-off record that displays in Ledger.</td>
</tr>
<tr>
<td><strong>Link to Ledger</strong></td>
<td>Matter ID, matter description, client sort, statement number or billing party used to select a statement when entering a cash receipt.</td>
</tr>
<tr>
<td><strong>Matters</strong></td>
<td>ProLaw tracks all of the firm's separate actions and cases as Matters. As each new action occurs, a new matter should also be created. Once the matter has been created, the firm can use that matter to track billing information, case data, events, documents, and any other matter-specific information. Matters are used to track all of the firm's activities.</td>
</tr>
<tr>
<td><strong>Matter Type</strong></td>
<td>The type of billing arrangement for the matter. For example, hourly fee, contingent or administrative. Administrative matters are excluded from fee and revenue analysis reports.</td>
</tr>
<tr>
<td><strong>Parent events</strong></td>
<td>The top level event in a hierarchy. The parent-child relationship can be viewed on the contact's or matter's Events tab. In previous versions of Westlaw Legal Calendaring, these were known as trigger codes.</td>
</tr>
<tr>
<td><strong>Payable</strong></td>
<td>A check that has not been printed. Payables are entered in Journals.</td>
</tr>
<tr>
<td><strong>Payee Contact</strong></td>
<td>The contact assigned to a check.</td>
</tr>
<tr>
<td><strong>Periodic Retainer</strong></td>
<td>A set amount to be charged for fees to the client each billing cycle regardless of the services performed. Entered on a matter's Billing tab.</td>
</tr>
<tr>
<td><strong>Posting Type</strong></td>
<td>Distinguishes between cash and accrual postings in Journals.</td>
</tr>
<tr>
<td><strong>Pre-Bill</strong></td>
<td>Also known as billing memos. Pre-bills are distributed to attorneys for editing before the statement run.</td>
</tr>
<tr>
<td><strong>Preferences</strong></td>
<td>Each area of ProLaw allows users to set user-specific and global settings that impact the functionality of ProLaw. These settings are called &quot;preferences.&quot;</td>
</tr>
<tr>
<td><strong>Professional</strong></td>
<td>Any person who uses ProLaw or has their time tracked in ProLaw is a professional.</td>
</tr>
<tr>
<td><strong>Query</strong></td>
<td>A query is structured search in a given window, using common words and operators (from the Query Builder button) to obtain a data (generally for a report).</td>
</tr>
<tr>
<td><strong>Record View</strong></td>
<td>The detailed view of a single record.</td>
</tr>
<tr>
<td><strong>Retainer</strong></td>
<td>Cash received from a client to retain services prior to work being performed. Usually tracked in a trust account. Sometimes deposited into the operating account and treated as unapplied cash.</td>
</tr>
<tr>
<td><strong>Search View</strong></td>
<td>A grid that displays a limited amount of information about multiple records. Most areas in ProLaw have a search view.</td>
</tr>
<tr>
<td><strong>Soft Cost</strong></td>
<td>A cost transaction that is estimated in terms of passing it along to the client, or for which the firm does not receive an invoice specific to that charge. For example, in-house photocopies are soft costs since the price per copy is an estimate based on the service contract for the photocopier and the amount of copies the firm usually makes in a month, or are tracked in cost recovery software. But the firm does not receive an invoice for all the copies they ran in-house for the matter.</td>
</tr>
<tr>
<td><strong>Stage</strong></td>
<td>The stage of a transaction (batch, WIP or billed).</td>
</tr>
<tr>
<td><strong>Statement</strong></td>
<td>An invoice of fees and expenses sent to client. Statements appear in Ledger.</td>
</tr>
<tr>
<td><strong>Statement Body</strong></td>
<td>The actual layout of the statement.</td>
</tr>
</tbody>
</table>
**Statement Format**
The name of the statement format and various options that determine how the format functions. Discussed in Statements.

**Toolbar**
A row of buttons that display at the top of each window or list.

**Transaction**
The time spent by a professional that can be billed to a client (fee transactions), or a hard or soft cost that can be billed to a client. It is also possible to track administrative time or costs that will not be billed to a client.

**Unapplied Cash**
Unapplied cash is cash received from a client that is deposited into the main checking account when there is no outstanding statement to apply.

**Write-Down**
A write-down occurs when the amount of a transaction is reduced prior to billing. Not to be confused with write-offs, which reduce the client's A/R after the statement has been run.

**Write-Off**
A write-off is a journal entry to reduce a client's accounts receivable balance once it has been determined that the A/R will not be recovered.

---

**PICKLISTS, LOOKUPS**

**ADVANCED LOOKUPS**

Advanced lookups do not validate as you type in the field the way that simple lookups do. Therefore you can initially type anything you want in advanced lookup fields; ProLaw validates what you typed when you try to leave the field. If you type in something that does not exist on the list, you will be prompted to select a valid record (see below example).

You can also click the ellipses on the right-hand side of the field to open the lookup's search form. Any text you already entered in the field before you pressed the ellipses will be passed to the list and the search results will display.

Once the advanced lookup is open, find or add the desired record and click OK. You will be returned to the window that invoked the lookup.

Advanced lookups are found throughout ProLaw. The Companies and Professionals windows are advanced lookups. The Contacts and Matters windows are often accessed as advanced lookups: When you assign a matter to a transaction, the matter-related fields on the transaction are advanced lookup fields to Matters. When you relate a contact to a matter, the Full Name and Company fields are advanced lookups to Contacts. And so on.
EXAMPLE OF AN ADVANCED LOOKUP

In the below example, note how there are ellipses next to the Company field in Contacts.

One could just press the ellipses to open the Companies list, but in our example the user typed in a company that was not on their list. They then pressed the Tab key to exit the field (or clicked on another field or tab with the mouse). The Companies list opens with the company they typed in the contact in Search for:

The search results grid is empty; there is no company in the list called "Volmare Publishing." The user needs to either add the company to the Companies list or search for and select a company that is on the list and then press OK, or press Cancel and then change what they typed in the field in Contacts.
GETTING STARTED

The OK and Cancel buttons on the right-side of the advanced lookup window only appear if the list opened because a value from it is being assigned to another record. If the user had instead opened the Companies list from the Lists submenu of the Tools menu in Contacts, the OK and Cancel buttons would not appear, because then the user would just be managing the list. Not assigning a value from it to a contact.

When an advanced lookup is open, you can perform most of the actions that you can perform when you open the window normally. For example, if you open the Matters list because you are assigning a matter to a transaction, you can add new matters, delete matters, perform conflict searches, add events, etc. in the lookup. You just have to remember to click OK (or Cancel) to return to the Transactions window when you are done working in the Matters lookup. Some windows have a few actions that can only be performed when the window is opened normally. For example, you can’t go into Design and manage custom tabs if you are working in a Matters lookup.

Advanced lookups can cause confusion in new users; they may not understand why ProLaw opened another window when they were, say, just adding a contact as in our example above. If the user doesn’t realize they are being prompted to add a new value to the list or find a value that does exist on the list, they will simply press the Cancel button, and try to exit the original field again. The list will open again, and the user will feel stuck. It is therefore very important to teach new users how ProLaw’s advanced lookups work.

PRINT GRID/CALENDAR

Search results can be printed either by running a ProLaw report, or just printing the grid. If the grid does not contain all the information you need, generating an actual report is necessary. However, printing the grid is faster and easier than opening the report window, selecting the report, setting the report’s parameters, and so on. Therefore, on those occasions when the grid contains all the necessary information, printing it directly is often the preferred course. You can also save a grid to a file without printing it using Save Grid button.

PRINTING GRIDS

For example, say you want to print the following sample search results in Matters.

After you order, group, and/or filter the grid, click Print Grid. A preview window displays:
Select the printer, paper size and orientation. You can also zoom and/or change the width of the display prior to printing. Then press Print (or Ctrl+P) to print the grid.

PRINTING THE DASHBOARD CALENDAR

ProLaw reports are not used to print the Dashboard calendar; the "print grid" functionality is used instead. To print the calendar that appears on the Dashboard, select the date range and view you want your printout to have, then press Print Grid. A preview window similar (but not identical) to the one displayed when printing grids displays.

The Dashboard calendar's preview window is slightly different from the window that appears when printing grids. The printer options do not appear at the top of the page. There are no Print/Cancel buttons on the bottom of the window. The Zoom, page width, and Print buttons are all the same, however.
There is a **Search** field at the bottom left of the screen, and when you use the search function, you can copy any text it highlights to your clipboard. Search for text that appears in the printout and press the **Enter** key. If any matching text is found, the **Copy** button becomes enabled. Press it to copy the highlighted text to your clipboard.

**RECENT CONTACTS AND MATTERS WINDOW**

**VIEW RECENTLY ACCESSED CONTACTS AND MATTERS**

If you work in contacts and matters, but do not like opening Contacts or Matters and usually work on a relatively static list of records, you might find the Recent window useful. The Recent window automatically lists your recently-accessed contacts and matters without requiring you to open Contacts or Matters. Both types of records appear in the same window.

You set up ProLaw to display the Recent window when ProLaw opens. This can be done under either the Toolbar or the Dashboard. The list displays the same contacts and matters that display on your Recent views in the Contacts and Matters windows. You can open a contact or matter record from the Recent window by double-clicking it or highlighting its row and clicking the related hotkey.

**Note**: You must have security to view Contacts and/or Matters in order to be able to use the Recent window. Refer to Security for further details.
To enable the Recent window:

1. Follow the steps for accessing the Dashboard preference settings.
2. Select the **Use Recent Window** check box.
3. Click the **OK** button.

If you have the Recent window enabled but not open because you closed it after ProLaw loaded, do this:

- **Dashboard** - Select **Tools/Open Recent Window**.
- **Toolbar** - Right-click the toolbar and select **Open Recent Window** from the pop-up menu.

The records that appear on the Recent window are used as defaults in other ProLaw windows. See Defaulting the Matter or Contact for more information.

**DEFAULTING THE MATTER OR CONTACT**

The Recent window is used to determine defaults when using the event and time entry windows on the Dashboard and in Pro Filing. To understand how and when ProLaw defaults a matter/contact from the Recent window, you need to be aware of two things. One is that the event entry windows remember whether you created a contact or matter event the last time you were in that window; the other is that while the Recent window displays both contacts and matters, ProLaw pays the most attention to the one that really was accessed most recently-either the most-recently accessed contact, or matter.

The time and event entry windows use the most-recently accessed record only when the Recent window is open. If you have the Recent window enabled, but closed, matter and contact do not default.

The time and event entry windows also only default from the Recent window if the type of record you are creating is the same type as the record you most recently accessed. If you last accessed a contact, the Time Entry window will have no default matter.

Further, the event entry windows only default the matter or contact if the last time you were in the Create Event window, you created an event of that type. For example, if you create a Contacts document, then access a matter, then open the Create Document window again, the window will default to Contacts events and have no default contact. If you change it to Matters events, it will have no default matter. Similarly, if you create a Matters docket then go access a contact, then reopen the Create Docket window, it will default to creating a Matters event with no matter defaulted, and if you change it to Contacts events there will still not be a default contact. However, if you create a Contacts document, access a contact, and then open the Create Document window again, it defaults to Contacts events and does have the contact filled in.

You should also be aware that the various Create Event windows remember whether you created a Contacts or Matter event in that window, but not the other Create Event windows. For example, if you create a Contacts note event, but the last time you opened the Create Document window you created a Matters event, the next time you open the Create Document window again, it will default to matters. Only the Create Note window will default to contacts.
## KEYBOARD SHORTCUTS

### PROLAW

<table>
<thead>
<tr>
<th>KEYSTROKE</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAB</td>
<td>Move cursor to next field</td>
</tr>
<tr>
<td>SHIFT+TAB</td>
<td>Move cursor to previous field</td>
</tr>
<tr>
<td>F2</td>
<td>Bring the search view window to the front</td>
</tr>
<tr>
<td>F5</td>
<td>Refresh screen display</td>
</tr>
<tr>
<td>CTRL+A</td>
<td>Add new record</td>
</tr>
<tr>
<td>CTRL-D</td>
<td>Delete selected record</td>
</tr>
<tr>
<td>SHIFT+</td>
<td>Bring up entire picklist</td>
</tr>
<tr>
<td>CTRL+X</td>
<td>Cut</td>
</tr>
<tr>
<td>CTRL+C</td>
<td>Copy</td>
</tr>
<tr>
<td>CTRL+O</td>
<td>Open a record</td>
</tr>
<tr>
<td>CTRL+S</td>
<td>Save a record</td>
</tr>
<tr>
<td>CTRL+V</td>
<td>Paste</td>
</tr>
<tr>
<td>CTRL+P</td>
<td>Open the Run Reports window.</td>
</tr>
<tr>
<td>CTRL+T</td>
<td>Add Time Entry (in those windows where the Add Time Entry button/function exists).</td>
</tr>
<tr>
<td>ESC</td>
<td>Undo last action or data entry. Press twice to cancel an action or process (e.g., Pro Filing).</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>Quick Find view</td>
</tr>
<tr>
<td>Ctrl+Q</td>
<td>Query view</td>
</tr>
<tr>
<td>Ctrl+F4</td>
<td>Close window</td>
</tr>
</tbody>
</table>

### DASHBOARD

<table>
<thead>
<tr>
<th>KEYSTROKE</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+K</td>
<td>Add docket</td>
</tr>
<tr>
<td>Ctrl+M</td>
<td>Add document</td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>Add note event</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Print calendar</td>
</tr>
<tr>
<td>Shift+Ctrl+C</td>
<td>Add check request</td>
</tr>
</tbody>
</table>
## CONTACTS

<table>
<thead>
<tr>
<th>KEYS</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+N</td>
<td>Name detail</td>
</tr>
<tr>
<td>Ctrl+R</td>
<td>Address detail</td>
</tr>
<tr>
<td>Ctrl+G</td>
<td>Convert events to e-mail agent</td>
</tr>
<tr>
<td>Ctrl+H</td>
<td>Refresh Outlook</td>
</tr>
<tr>
<td>Ctrl+M</td>
<td>Merge</td>
</tr>
<tr>
<td>Ctrl+Alt+K</td>
<td>Add docket</td>
</tr>
<tr>
<td>Ctrl+Alt+L</td>
<td>Add linked docket</td>
</tr>
<tr>
<td>Ctrl+Alt+M</td>
<td>Add document</td>
</tr>
<tr>
<td>Ctrl+Alt+N</td>
<td>Add note</td>
</tr>
</tbody>
</table>

## DASHBOARD

<table>
<thead>
<tr>
<th>KEYS</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+K</td>
<td>Add docket</td>
</tr>
<tr>
<td>Ctrl+T</td>
<td>Add time entry</td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>Add note</td>
</tr>
<tr>
<td>Ctrl+M</td>
<td>Add document</td>
</tr>
</tbody>
</table>
## Events Off the Dashboard

<table>
<thead>
<tr>
<th>KEYS/STROKE</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+W</td>
<td>Document worklist view</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td>Reassign pleading index numbers</td>
</tr>
<tr>
<td>Ctrl+L</td>
<td>Load document</td>
</tr>
<tr>
<td>Ctrl+M</td>
<td>Email event</td>
</tr>
<tr>
<td>Ctrl+E</td>
<td>Complete event</td>
</tr>
<tr>
<td>Ctrl+K</td>
<td>Mark</td>
</tr>
</tbody>
</table>

## Files

<table>
<thead>
<tr>
<th>KEYS/STROKE</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>F9</td>
<td>Check in/out</td>
</tr>
</tbody>
</table>

## Matters

<table>
<thead>
<tr>
<th>KEYS/STROKE</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Alt+K</td>
<td>Add docket</td>
</tr>
<tr>
<td>Ctrl+Alt+L</td>
<td>Add linked docket</td>
</tr>
<tr>
<td>Ctrl+Alt+M</td>
<td>Add document</td>
</tr>
<tr>
<td>Ctrl+Alt+N</td>
<td>Add note</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td>Matter ID detail</td>
</tr>
<tr>
<td>Ctrl+G</td>
<td>Convert events to e-mail agent</td>
</tr>
<tr>
<td>Ctrl+Alt+D</td>
<td>Docket subscription</td>
</tr>
</tbody>
</table>
GETTING STARTED

TRANSACTIONS

<table>
<thead>
<tr>
<th>KEYS / SHORTCUT</th>
<th>PURPOSE</th>
</tr>
</thead>
<tbody>
<tr>
<td>F7</td>
<td>Spell check</td>
</tr>
<tr>
<td>ALT+C</td>
<td>Copy selected transaction</td>
</tr>
<tr>
<td>CTRL+ALT+C</td>
<td>Mass copy selected transaction</td>
</tr>
<tr>
<td>CTRL+K</td>
<td>Mark transactions</td>
</tr>
<tr>
<td>CTRL+N</td>
<td>Narrative/Notes tab(s)</td>
</tr>
<tr>
<td>CTRL+W</td>
<td>Write up/down</td>
</tr>
<tr>
<td>CTRL+R</td>
<td>Transfer</td>
</tr>
<tr>
<td>CTRL+O</td>
<td>Transaction split</td>
</tr>
<tr>
<td>CTRL+H</td>
<td>Hold</td>
</tr>
<tr>
<td>CTRL+I</td>
<td>Hide</td>
</tr>
<tr>
<td>CTRL+B</td>
<td>No bill</td>
</tr>
<tr>
<td>CTRL+1</td>
<td>Remove pre-bill date</td>
</tr>
<tr>
<td>CTRL+M</td>
<td>Move to WIP</td>
</tr>
<tr>
<td>CTRL+U</td>
<td>Summary paragraph</td>
</tr>
<tr>
<td>CTRL+L</td>
<td>Add to Matters list</td>
</tr>
<tr>
<td>SHIFT+CTRL+I</td>
<td>Attach scanned image</td>
</tr>
<tr>
<td>Ctrl+Alt+O</td>
<td>Mass transaction split</td>
</tr>
</tbody>
</table>

JOURNALS

<table>
<thead>
<tr>
<th>KEYS / SHORTCUT</th>
<th>PURPOSE</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+N</td>
<td>Offsetting GL Accounts tab</td>
</tr>
<tr>
<td>CTRL+H</td>
<td>Hold</td>
</tr>
<tr>
<td>CTRL+T</td>
<td>Distribution tab</td>
</tr>
<tr>
<td>CTRL+E</td>
<td>Distribution Detail</td>
</tr>
<tr>
<td>CTRL+T</td>
<td>Transfer Trust</td>
</tr>
<tr>
<td>CTRL+Y</td>
<td>Auto-Pay</td>
</tr>
<tr>
<td>SHIFT+CTRL+M</td>
<td>Manual check</td>
</tr>
<tr>
<td>SHIFT+CTRL+S</td>
<td>Spoil checks</td>
</tr>
<tr>
<td>SHIFT+CTRL+V</td>
<td>Void checks</td>
</tr>
<tr>
<td>SHIFT+CTRL+I</td>
<td>Attach scanned image</td>
</tr>
<tr>
<td>Shift+Ctrl+C</td>
<td>Check request</td>
</tr>
<tr>
<td>Ctrl+B</td>
<td>Current batch</td>
</tr>
</tbody>
</table>